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Uvod 1
Što se nalazi u ovom poglavlju
• Pregled: stranica 1
• Pomo : stranica 3
• Podržani ure aji: stranica 3 
• Upute za upotrebu priru nika: stranica 5
• Sigurnost korisnika: stranica 6

Pregled

Zahvaljujemo što ste Medtronic Diabetes odabrali za partnera koji e
i vama i bolesnicima olakšati lije enje dijabetesa. Vjerujemo da ete imati 

koristi od vrhunske tehnologije softvera CareLink™ Pro i jednostavnog
korisni kog su elja kojim se upravlja putem izbornika.

Ovaj korisni ki priru nik opisuje kako koristiti CareLink Pro za prikupljanje 
i pohranu podataka o lije enju bolesnika i dijagnostici te za stvaranje izvješ a. 
On opisuje i mogu nost pristupa podacima o glukozi dobivenim od pumpe, 

mjera a i senzora, a koje su bolesnici prenijeli u CareLink™ Personal, mrežni 
sustav za upravljanje lije enjem koji sura uje sa softverom CareLink Pro.
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Zna ajke     

CareLink Pro softver je za osobna ra unala namijenjen upravljanju 
lije enjem dijabetesa. Raspolaže sljede im zna ajkama:

• Zapisi o bolesniku mogu se stvarati radi pohrane podataka prikupljenih 
iz bolesnikova ure aja, kao i podataka o lije enju s njegova ra una za 
CareLink Personal. 

• Podaci iz inzulinskih pumpi, monitora i mjera a glukoze u krvi mogu 
se slati sustavu, pohranjivati i zatim koristiti za generiranje izvješ a.

• Postoji i mogu nost povezivanja sa sustavom CareLink Personal, pri 
emu se omogu uje pristup podacima s ure aja koje su bolesnici ondje 

pohranili. To je idealno za stvaranje aktualnih izvješ a izme u posjeta 
lije niku te može o itavanje podataka s ure aja tijekom posjeta lije niku
u initi nepotrebnim. 

• Iz podataka s ure aja koji su pohranjeni u bolesnikovu zapisu mogu se 
stvarati razne vrste izvješ a o lije enju. Izvješ a olakšavaju pronalaženje 
odgovora na pitanja u sklopu lije enja, kao što su bolesnikovo pridržavanje 
propisane terapije, obrasci i iznimke.

• Sustav vas obavještava kada su dostupna ažuriranja softvera koja 
možete preuzeti i instalirati. To vam jam i da imate pristup najnovijim 
zna ajkama.

• Zna ajka Guide Me (Vodi me) po etnicima olakšava korištenje 
softvera CareLink Pro. Ona nudi savjete o zadacima koje obavljaju.

• Integrirani sustav pomo i dostupan je u cijelom softveru i pruža 
informacije o specifi nim podru jima.

Sigurnost     

• CareLink Pro može se zaštititi lozinkom.
• Prijenos podataka o bolesniku iz softvera CareLink Personal šifrira se 

pomo u standardne SSL tehnologije.

Povezani dokumenti     

Svaki od ovih dokumenata Medtronic MiniMed sadrži informacije koje 
su specifi ne za ure aj i koje nisu detaljno opisane u ovom korisni kom 
priru niku. 

NAPOMENA:
informacije o mjera ima

drugih proizvo a a
potražite u uputama

koje se isporu uju
zajedno s mjera em.

• Korisni ki priru nik za inzulinsku pumpu Paradigm
• Korisni ki priru nik za monitor koji prati podatke 

u stvarnom vremenu Guardian REAL-Time
• Korisni ki priru nik za zna ajke senzora
• Korisni ki priru nik za ComLink
• Korisni ki priru nik za CareLink USB
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Pomo

Ako vam je potrebna dodatna pomo  o ovom sustavu, obratite se 
lokalnom predstavniku u svojoj državi. Informacije o me unarodnim 
kontaktima možete prona i putem sljede eg URL-a:

http://www.medtronicdiabetes.com/help/contact/locations.html

NAPOMENA: neki
ure aji koje podržava

ovaj softver možda nisu
dostupni u svim

državama u kojima
je ovaj softver odobren

za korištenje.

Podržani ure aji

CareLink Pro prima podatke iz sljede ih ure aja.           

Inzulinske pumpe / monitori glukoze 

Pumpe Medtronic MiniMed 508

Pumpe Medtronic MiniMed Paradigm 
511, 512, 712, 515, 715, 522, 722, 522K, 722K, 
Paradigm® REAL-Time Revel™ (523, 723, 
523K, 723K),  Paradigm® Veo™ (554, 754)  

Monitor Guardian REAL-Time CSS-7100
CSS-7100K

Proizvo a Mjera i glukoze u krvi     

Partnerski ure aji 
Medtronic Diabetes:

• Bayer CONTOUR® LINK
• LifeScan OneTouch® UltraLink™

• Monitor glukoze u krvi BD Paradigm Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2
• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer:

• BREEZE™

• BREEZE™ 2
• CONTOUR®
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BD: • Logic®

Obitelj proizvoda Bayer 
Ascensia® DEX®, uklju uju i
ove kompatibilne mjera e:

• Ascensia® DEX®

• Ascensia® DEX® 2 
• Ascensia® DEXTER-Z® II
• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 
• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Obitelj proizvoda Bayer 
Ascensia ELITE™, uklju uju i
ove kompatibilne mjera e:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva
• Accu-Chek® CompactPlus
• Accu-Chek® Compact
• Accu-Chek® Active

Komunikacijski ure aji                 

 Com-Station

Koristi se s pumpom MiniMed 508. 
(Pojedinosti o potrebnom hardveru 
potražite u korisni kom priru niku 
za Com-Station.)

ComLink

Koristi se s pumpom MiniMed Paradigm 
i monitorom Guardian REAL-Time. 
(Pojedinosti o potrebnom hardveru 
potražite u korisni kom priru niku 
za ComLink.) 

Monitor glukoze u krvi 
Paradigm Link®

Koristi se s pumpom MiniMed Paradigm 
i monitorom Guardian REAL-Time. 
(Pojedinosti o potrebnom hardveru 
potražite u korisni kom priru niku za 
monitor glukoze u krvi Paradigm Link®.)

CareLink™ USB
Koristi se s pumpom MiniMed Paradigm 
i monitorom Guardian REAL-Time.

Kabel za podatkovnu komunikaciju

Koristi se s mjera ima glukoze u krvi 
drugih proizvo a a. Svaki proizvo a
mjera a isporu uje kabel za podatkovnu 
komunikaciju.

Proizvo a Mjera i glukoze u krvi     
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Ekvivalentni ure aji       

Prilikom dodavanja ure aja u sustav odabirete marku i model s popisa. 
Ako marka i model ure aja nisu na popisu, u sljede oj tablici potražite 
ekvivalentan ure aj koji možete upotrijebiti.

NAPOMENA: mjera i se
mogu naru iti od tvrtki

koje ih proizvode.

Naru ivanje                       

Obratite se lokalnom predstavniku u svojoj državi da biste naru ili proizvode 
Medtronic Diabetes. Informacije o me unarodnim kontaktima tvrtke 
Medtronic možete prona i putem sljede eg URL-a:

http://www.medtronicdiabetes.com/help/contact/locations.html

Upute za upotrebu priru nika

U rje niku potražite definicije pojmova i funkcija. Konvencije korištene 
u ovom priru niku definirane su u sljede oj tablici.

Korisni ki priru nik prikazuje uzorke softverskih zaslona. Zasloni stvarnog 
softvera mogu se donekle razlikovati.

Ako bolesnik koristi jedan 
od sljede ih ure aja

Odaberite ovaj ure aj

• Bayer Ascensia® DEX®

• Bayer Ascensia® DEX® 2
• Bayer Ascensia® DEXTER-Z® II
• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 
• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™

Pojam/stil Zna enje

Kliknite Pritisnuti lijevu tipku miša iznad objekta na zaslonu 
da biste ga odabrali 

Dvokliknite Dvaput pritisnuti lijevu tipku miša iznad objekta na 
zaslonu da biste ga otvorili

Kliknite desnom tipkom 
miša

Pritisnuti desnu tipku miša iznad objekta na zaslonu 
da biste prikazali drugi prozor ili izbornik

Podebljani tekst
Koristi se za mogu nost izbornika ili put izbornika. 
Na primjer: Patient > New Patient (Bolesnik > Novi 
bolesnik).
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Sigurnost korisnika

Indikacije za upotrebu 

Sustav CareLink Pro koristi se kao alat koji olakšava život s dijabetesom. 
Svrha je tog sustava prikupljanje informacija koje se prenose s inzulinskih 
pumpi, mjera a glukoze i sustava za stalno pra enje glukoze te njihovo 
pretvaranje u izvješ a softvera CareLink Pro. Izvješ a sadrže informacije 
koje se mogu koristiti za identificiranje trendova i pra enje dnevnih 
aktivnosti – kao što su unos ugljikohidrata, vremena obroka, davanje 
inzulina i vrijednosti glukoze. 

Upozorenja 

• Sustav trebaju koristiti zdravstveni djelatnici s iskustvom u kontroli 
dijabetesa.

• Rezultati sustava nisu pouzdan temelj za davanje zdravstvenih savjeta 
te ih ne bi trebalo tako koristiti. 

• Ovaj proizvod treba koristiti isklju ivo s podržanim ure ajima navedenima 
u ovom dokumentu (pogledajte odjeljak Podržani ure aji, 
na stranici 3.)

• Bolesnicima treba preporu iti da prate svoju razinu glukoze u krvi 
barem 4 do 6 puta dnevno.

• Bolesnike treba upozoriti da ne mijenjaju svoju terapiju bez 
savjetovanja sa zdravstvenim djelatnikom.

• Bolesnike treba upozoriti da odluke o lije enju trebaju donositi na 
temelju smjernica koje su dobili od zdravstvenog djelatnika i rezultata 
mjera a glukoze u krvi, a ne rezultata senzora glukoze.

Tekst pisan VELIKIM 
SLOVIMA Ozna ava gumb. Na primjer: SAVE (Spremi).

Tekst pisan u kurzivu Koristi se za nazive zaslona i polja. 
Na primjer: zaslon Reports (Izvješ a).

NAPOMENA: Dodatne informacije

OPREZ: Upozorava na opasnost koja, ako se ne izbjegne, može 
uzrokovati manje ili umjereno ošte enje softverskog 
programa ili opreme.

UPOZORENJE: Upozorava na potencijalnu opasnost koja, ako se ne 
izbjegne, može uzrokovati smrt ili tešku ozljedu. Može 
ozna avati i mogu nost teških nuspojava i sigurnosnih 
rizika.

Pojam/stil Zna enje
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Kontraindikacije 

Ovaj softver ne treba koristiti s ure ajima koji nisu navedeni u odjeljku 
Podržani ure aji, na stranici 3. Proizvod, uz to, ne treba koristiti za 
lije enje drugih zdravstvenih poreme aja osim dijabetesa.

Ako je na vašem ra unalu trenutno pokrenut neki od sljede ih programa, 
zatvorite ga prije otvaranja ovog softvera:

• softver CGMS® System Solutions™

• softver Solutions® Pumps & Meters 

• softver Guardian® Solutions®

• ParadigmPAL™

• CareLink™ Personal 

• softver Solutions® za CGMS® iPro
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Kretanje po sustavu 2
Što se nalazi u ovom poglavlju
• Pregled: stranica 8
• Otvaranje CareLink Pro: stranica 8
• Radni prostori: stranica 10
• Traka glavnog izbornika: stranica 12
• Alatna traka: stranica 12
• Zna ajka Guide Me (Vodi me): stranica 13
• Veze Learn More (Saznajte više): stranica 14
• Sustav pomo i: stranica 14

Pregled

U ovom ete se poglavlju upoznati s grafi kim korisni kim su eljem 

(GUI-jem) softvera CareLink™ Pro. Korisni ko se su elje sastoji od 
izbornika, alatne trake, navigacijske trake, radnih prostora i prozora 
Guide Me (Vodi me). 

Otvaranje CareLink Pro                  

1 Dvokliknite ikonu CareLink Pro na radnoj površini ra unala.

Ako vaša ambulanta zahtijeva unos lozinke, prikazuje se zaslon za 
prijavu.

 Ikona za program
CareLink Pro na
radnoj površini
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a. Upišite svoju lozinku u polje Password (Lozinka).

NAPOMENA: traženje
lozinke neobavezna je

zna ajka koja se
postavlja tijekom

postupka instalacije.

b. Kliknite LOGIN (Prijava).

Prikazat e se po etni zaslon.

2 Da biste stvorili zapis o novom bolesniku, kliknite NEW PATIENT 
(Novi bolesnik). Da biste otvorili zapis o bolesniku s popisa bolesnika 
u sustavu, kliknite OPEN PATIENT (Otvori bolesnika).

        

Alavni izbornici

Aktivni radni 
prostor

Pristupi popisu bolesnikaDodaj novog bolesnika

Navigacijska traka

Traka stanja

Gumb radnog
prostora Reports

(Izvješ a)
Gumb radnog

prostora Devices
(Ure aji)

Gumb radnog
prostora Profile

(Profil)

Prikaži/sakrij prozor Guide Me (Vodi me)
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Radni prostori

NAPOMENA: u drugim
poglavljima ovog

korisni kog priru nika
potražite pojedinosti
o radnim prostorima

i o na inu njihova
korištenja.

Ako je zapis bolesnika otvoren, možete kliknuti jedan od gumba na 
navigacijskoj traci da bi se prikazao odgovaraju i radni prostor. Te 
radne prostore koristite za unos ili odabir podataka radi obavljanja 
odre enih zadataka za tog bolesnika u softveru CareLink Pro.

• Profil: omogu uje održavanje pohranjenih podataka o bolesniku, kao 
što su ime i datum ro enja. Taj vam radni prostor ujedno omogu uje
povezivanje s bolesnikovim sustavom CareLink Personal.

• Ure aji: omogu uje pohranu podataka potrebnih za o itavanje 
bolesnikovih ure aja.

• Izvješ a: omogu uje odabir parametara i izvješ a koji e se generirati 
za bolesnika.

Dok ne dodate i ne spremite profil za nekog bolesnika, za njega je 
dostupan samo radni prostor Profile (Profil). Dok za nekog bolesnika 
ne dodate ure aje, za njega su dostupni samo radni prostori Profile
(Profil) i Devices (Ure aji).
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Radni prostori

Radni prostor Devices (Ure aji)

Radni prostor Profile (Profil)

Radni prostor Reports (Izvješ a)

Profile 
(Profil)

Devices
(Ure aji)

Reports 
(Izvješ a)
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Traka glavnog izbornika

Sljede a slika prikazuje mogu nosti dostupne na itavom glavnom 
izborniku. Nekima od tih mogu nosti izbornika može se pristupiti putem 
tipkovni kih pre aca navedenih pored mogu nosti (npr. Ctrl+N za 
mogu nost New Patient (Novi bolesnik)). Nekim mogu nostima izbornika 
možete pristupiti putem navigacijske trake ili alatne trake.

Alatna traka

Alatna traka softvera CareLink Pro omogu uje brz pristup esto 
korištenim zna ajkama. Alatna traka sadrži sljede e gumbe:

Gumb Naziv Funkcija

Add Patient 
(Dodaj bolesnika)

Otvara radni prostor Profile (Profil) da biste 
u sustav mogli dodati zapis o novom 
bolesniku.

Open Patient 
(Otvori bolesnika)

Otvara tablicu Patient Lookup (Traženje 
bolesnika) u kojoj možete izabrati zapis 
postoje eg bolesnika koji želite pogledati.

Guide Me 
(Vodi me)

Prikazuje ili sakriva prozor Guide Me 
(Vodi me). Kliknite da biste vidjeli 
kontekstne savjete sustava. 
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Kartice bolesnika

Kada otvorite zapis bolesnika, uz alatnu se traku prikazuje kartica 
s imenom bolesnika. Ako je kartica aktivna, to zna i da su zapis 
o bolesniku i radni prostor aktivni te da za tog bolesnika možete 
obavljati zadatke u programu CareLink Pro. 

Zapis bolesnika može se aktivirati jednostavnim klikom na karticu 
bolesnika. Da biste zatvorili zapis, kliknite gumb CLOSE (Zatvori) 
na njegovoj kartici.

Zna ajka Guide Me (Vodi me)

Zna ajka Guide Me (Vodi me) dostupna je svuda u softveru 
CareLink Pro. Ona otvara prozor s kontekstnim savjetima o radnjama 
koje možete poduzeti iz dijela sustava koji je trenutno aktivan. Prozori 
zna ajke Guide Me (Vodi me) mogu sadržavati i veze >> learn more
(saznajte više). Kada ih kliknete, te vas veze vode do relevantnog 
odjeljka mrežne pomo i u kojem možete prona i dodatne informacije. 
Zna ajka Guide Me (Vodi me) prema zadanim je postavkama 
omogu ena. No možete je isklju iti u bilo kojem trenutku.

Gumb CLOSE 
(Zatvori) 

Neaktivna kartica Aktivna kartica

Gumb Close
(Zatvori)
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Uklju ivanje i isklju ivanje zna ajke Guide me (Vodi me) 

Mogu nost gumba

• Kliknite gumb GUIDE ME (Vodi me) da biste uklju ili ili isklju ili 
zna ajku Guide Me (Vodi me).

Mogu nost izbornika

• Odaberite Help > Guide Me (Pomo  > Vodi me) da biste aktivirali ili 
deaktivirali tu zna ajku.

Veze Learn More (Saznajte više)     

Veze Learn More (Saznajte više) vode vas do povezane teme u sustavu 
mrežne pomo i. One se nalaze svuda u sustavu, unutar prozora Guide Me 
(Vodi me) ili softvera. Ako niste sigurni kako nastaviti ili koje vrijednosti 
morate unijeti, kliknite >> learn more (saznajte više).

Sustav pomo i

Sustav pomo i dostupan je kao podrška u korištenju sustava 
CareLink Pro. Sadrži informacije o tome kako obaviti zadatke 
u softveru. 

Da biste pristupili sustavu pomo i, u inite nešto od navedenog:

• Odaberite Help > Medtronic CareLink Pro Help
(Pomo  > Pomo  za CareLink Pro). 

• Pritisnite tipku F1.

Gumb Guide Me
(Vodi me)

Veza learn more (saznajte više)



Korisni ki priru nik za CareLink™ Pro    Uvod u rad      15

Uvod u rad 3
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 15
• Otvaranje i zatvaranje zapisa o bolesniku: stranica 17
• Postavljanje preferenci sustava: stranica 18 

Ovo vas poglavlje vodi kroz pokretanje softvera CareLink™ Pro,
otvaranje i zatvaranje zapisa o bolesniku te postavljanje preferenci 
koje se primjenjuju na sve bolesnike u sustavu. 

Prije po etka

Ako prvi put koristite CareLink Pro, obavezno postavite Op e
preference (pogledajte poglavlje Op e preference, na stranici 19).
Te preference odre uju kako se odre ene stavke prikazuju u softveru 
i izvješ ima te kako želite da sustav komunicira s internetom.

Preference možete postaviti u bilo kojem trenutku. Možda poželite 
pri ekati dok se ne upoznate sa softverom CareLink Pro da biste 
postavili druge preference.
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Primarni zadaci sustava

U sljede oj su tablici prikazani glavni zadaci ije se izvršavanje 
preporu uje pri prvom postavljanju i korištenju programa CareLink Pro. 
Navodi se i u kojem se dijelu korisni kog priru nika opisuje koji 
zadatak.

Korak Lokacija

Upoznajte se s korisni kim su eljem 
programa CareLink Pro. Poglavlje 2, Kretanje po sustavu

Definirajte globalne sistemske 
mogu nosti koje e vaša ambulanta 
koristiti.

Postavljanje preferenci sustava, 
na stranici 18

Stvorite profile za svakog bolesnika. Dodavanje novih profila, na stranici 25

Povežite se s ra unima bolesnika 
u softveru CareLink Personal.

Povezivanje sa sustavom CareLink 
Personal (nije obavezno), 
na stranici 26

Dodajte pumpu i mjera e bolesnika 
u njihov profil. Dodavanje ure aja, na stranici 36

itajte podatke s pumpe i mjera a
bolesnika.

itanje podataka iz ure aja, 
na stranici 43

Postavite i generirajte izvješ a za svakog 
bolesnika.

Stvaranje izvješ a, na stranici 46

Redovito stvarajte sigurnosne kopije 
baze podataka programa CareLink Pro.

Stvaranje sigurnosne kopije baze 
podataka, na stranici 59

Ažurirajte softver CareLink Pro.
Primjena ažuriranja softvera, 
na stranici 58
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Otvaranje i zatvaranje zapisa o bolesniku

Otvaranje zapisa o bolesniku         

Istodobno može biti otvoreno najviše šest bolesni kih zapisa. Ako 
još niste stvorili profile bolesnika, pogledajte odjeljak Dodavanje novih 
profila, na stranici 25.

1 Odaberite File > Open Patient (Datoteka > Otvori bolesnika) ili 
kliknite gumb OPEN PATIENT (Otvori bolesnika). Prikazuje se 
popis bolesnika sli an sljede em.

NAPOMENA: ako
primite poruku

s napomenom da ste
otvorili previše zapisa

o bolesniku, kliknite OK
(U redu), zatvorite zapis

i nastavite.

2 Prona ite bolesnika na popisu tako da upišete njegovo ime ili dio imena 
u polje Find a Patient (Prona i bolesnika). Kada je bolesnik istaknut 
na popisu, kliknite OPEN (Otvori), dvokliknite popis ili pritisnite tipku 
ENTER. Po popisu se možete kretati i korištenjem strelica za gore 
i dolje na tipkovnici. 

Za bolesnika se prikazuje radni prostor Devices (Ure aji) (ako ure aji
još nisu dodani) ili radni prostor Reports (Izvješ a).

3 Da biste vidjeli radni prostor Profile (Profil) za bolesnika, kliknite gumb 
PROFILE (Profil) na navigacijskoj traci.

Zatvaranje zapisa o bolesniku        

1 Provjerite je li zapis bolesnika koji želite zatvoriti aktivan (kartica je istaknuta).

2 U inite nešto od navedenog:
a. Odaberite File > Close Patient (Datoteka > Zatvori bolesnika).
b. Kliknite gumb CLOSE (Zatvori) na kartici bolesnika.
c. Pritisnite tipke Ctrl i F4.

Gumb Open Patient
(Otvori bolesnika)

Gumb Profile (Profil)

Gumb Close (Zatvori)
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Postavljanje preferenci sustava

Te se preference primjenjuju na sve bolesnike u sustavu. Informacije 
o preferencama koje utje u samo na pojedine bolesnike potražite 
u odjeljku Provjera postavki izvješ a, na stranici 50.

Preference su prikazane u sljede im grupama:

• General (Op enito)

– Glucose units (Jedinice glukoze)
– Carbohydrate units (Jedinice ugljikohidrata)
– Communications (Komunikacija)
– Troubleshooting (Otklanjanje poteško a)

• Patient Profile (Profil bolesnika)

– odabir i raspore ivanje polja podataka u profilima bolesnika
• Patient Lookup (Traženje bolesnika)

– modificiranje i promjena redoslijeda polja koja se prikazuju kada 
odaberete Open Patient (Otvori bolesnika) da biste prikazali popis 
bolesnika

• Report Generation (Stvaranje izvještaja)

– odabir polja podataka koja želite da se prikazuju kada odaberete 
unos u izvješ e Daily Detail (Dnevne pojedinosti) iz podatkovne 
tablice
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Op e preference  

1 Odaberite Tools > Options (Alati > Mogu nosti). Prikazuje se sljede i
prozor.

2 Kliknite gumb mogu nosti da biste odabrali željenu vrijednost.
– Glucose Units (Jedinice glukoze): mg/dL ili mmol/L
– Carbohydrate Units (Jedinice ugljikohidrata): grami ili razmjene
a. Ako ste odabrali razmjene za Carbohydrate Units (Jedinice 

ugljikohidrata), upišite odgovaraju i broj u polje grams are equal 
to 1 Exchange (grama vrijedi kao 1 razmjena).

3 Za sljede e mogu nosti odjeljka Communications (Komunikacije) 
klikom potvrdite (omogu ite) ili poništite (onemogu ite) potvrdni okvir:

NAPOMENA: obavezno
slijedite smjernice svoje

ambulante ili IT odjela
za postavljanje

komunikacijskih
preferenci.

– Automatically check for software updates (Automatsko traženje 
ažuriranja softvera): kada je ta mogu nost odabrana, svakom 
sustavu na kojem je pokrenut CareLink Pro poslat e se obavijest 
svaki put kada postane dostupno ažuriranje softvera. Aktivni e
korisnik tada imati mogu nost preuzimanja i instalacije ažuriranja. 
Da biste to sprije ili i uveli upravljanu distribuciju ažuriranja 
softvera, možete poništiti taj potvrdni okvir.

– Synchronize with CareLink™ Personal (Sinkronizacija sa 
softverom CareLink™ Personal): ako želite da sustav automatski 
sinkronizira podatke softvera CareLink Personal vaših bolesnika 
svaki put kada otvorite njihov profil, potvrdite okvir Synchronize with 
CareLink Personal (Sinkronizacija sa softverom CareLink Personal). 
Ako poništite taj potvrdni okvir, morat ete ru no sinkronizirati 
podatke iz programa CareLink Personal za svakog bolesnika.
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4 Kliknite da biste potvrdili ili poništili okvir u odjeljku Troubleshooting 
(Otklanjanje poteško a). Ako je potvrdni okvir odabran, program e
spremiti zapis s o itanjima ure aja radi otklanjanja poteško a.

5 Kliknite OK (U redu) da biste spremili op e preference. 
Preference profila bolesnika         

1 Odaberite Tools > Options (Alati > Mogu nosti). 

2 Kliknite karticu Patient Profile (Profil bolesnika). Prikazuje se sljede i
prozor.

Odabir podatkovnih polja 

1 Pomo u potvrdnih okvira dodajte željena polja.

NAPOMENA: First Name
(Ime) i Last Name

(Prezime) nije mogu e
ukloniti.

2 Da biste uklonili polje iz profila, poništite njegov potvrdni okvir.

3 Da biste polje u inili obaveznim, potvrdite okvir u stupcu Required
(Obavezno). Obavezna se polja moraju ispuniti radi stvaranja profila.

Pomo u potvrdnih okvira odaberite polja koja želite uvrstiti u profil. Koristite strelice 
prema gore i prema dolje da biste poredali polja.
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Dodavanje prilago enog polja         

1 Potvrdite okvir s lijeve strane praznog prilago enog polja.

2 Unesite tekst da biste polju dodijelili naziv (primjerice »Kontakt 
u slu aju nužde«). Taj e naziv polja biti prikazan na profilu bolesnika.

3 Da biste polje u inili obaveznim, potvrdite okvir u stupcu Required
(Obavezno).

NAPOMENA: da biste
prilago eno polje
uklonili iz profila,

poništite potvrdni okvir
pokraj polja koje želite

ukloniti.

Promjena redoslijeda podatkovnih polja         

• Odaberite polje koje želite premjestiti, a zatim kliknite strelicu prema 
gore ili dolje da biste ga premjestili. (Strelicama prikazanim pri vrhu i pri 
dnu možete pomaknuti polje potpuno na vrh ili na dno popisa.) 

Zatvaranje preferenci profila bolesnika

• Kada popis Field Order (Redoslijed polja) sadrži sva željena polja 
poredana ispravnim redoslijedom, kliknite OK (U redu).

Profili bolesnika sada sadrže polja i redoslijed polja koji ste upravo 
odabrali.

Preference traženja bolesnika         

1 Odaberite Tools > Options (Alati > Mogu nosti). 

2 Kliknite karticu Patient Lookup (Traženje bolesnika). Prikazuje se sljede i
prozor.

Strelice za
 gore i dolje

Pomo u potvrdnih okvira odaberite polja koja želite uvrstiti u tablicu Patient Lookup 
(Traženje bolesnika). Koristite strelice prema gore i dolje da biste poredali stupce.
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Odabir podataka za prikaz  

• Pomo u potvrdnih okvira odaberite vrstu podataka koju želite ili o istite
podatke koje ne želite prikazati u tablici Patient Lookup (Traženje 
bolesnika).

NAPOMENA: First Name
(Ime) i Last Name

(Prezime) nije mogu e
ukloniti.

Promjena redoslijeda stupaca  

• Da biste promijenili redoslijed stupaca u tablici Patient Lookup 
(Traženje bolesnika), odaberite stupac koji ete pomaknuti i kliknite 
strelice prema gore ili dolje. (Strelicama prikazanim pri vrhu i pri dnu 
možete pomaknuti podatkovni stupac potpuno na vrh ili na dno popisa.)

NAPOMENA:
podatkovni stupac pri

vrhu popisa Column
Display Order

(Redoslijed prikaza
stupaca) bit e prikazan
u prvom stupcu tablice

Patient Lookup
(Traženje bolesnika).

Podatkovni stupac pri
dnu bit e prikazan

u zadnjem stupcu
tablice.

Zatvaranje preferenci traženja bolesnika

• Kada popis Column Display Order (Redoslijed prikaza stupaca) sadrži 
sve željene podatke ispravnim redoslijedom, kliknite OK (U redu).

Tablica Patient Lookup (Traženje bolesnika) sada sadrži podatke 
i redoslijed stupaca koji ste upravo odabrali.

Preference generiranja izvješ a

Podatkovna tablica prikazuje se tijekom odabira u sklopu procesa 
generiranja izvješ a. Tablica bi trebala sadržavati podatke koji su 
zdravstvenom djelatniku najkorisniji za odre ivanje datuma za koje 
želi vidjeti izvješ a Daily Detail (Dnevne pojedinosti).

NAPOMENA: da biste
vidjeli kako se te

preference primjenjuju
na podatkovnu tablicu

tijekom stvaranja
izvješ a, pogledajte

odjeljak Odabir razdoblja
izvješ ivanja i datuma

uvrštavanja, na
stranici 52.

1 Odaberite Tools > Options (Alati > Mogu nosti). 

2 Kliknite karticu Report Generation (Generiranje izvješ a). Prikazuje se 
sljede i prozor.

Strelice za
 gore i dolje
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Odabir podataka za prikaz        

• Pomo u potvrdnih okvira odaberite vrstu podataka koje želite ili o istite
podatke koje ne želite prikazati u podatkovnoj tablici.

Promjena redoslijeda stupaca       

• Da biste promijenili redoslijed stupaca u podatkovnoj tablici, odaberite 
stupac koji ete pomaknuti i kliknite strelice gore ili dolje. (Strelicama 
prikazanim pri vrhu i pri dnu možete pomaknuti podatkovni stupac 
potpuno na vrh ili na dno popisa.)

NAPOMENA:
podatkovni stupac na

vrhu popisa Column
Order (Redoslijed

stupaca) bit e prikazan
u prvom stupcu

podatkovne tablice.
Stavke pri dnu bit e
prikazane u zadnjem

stupcu podatkovne
tablice.

Dovršenje preferenci generiranja izvješ a

• Kada popis Column Order (Redoslijed stupaca) sadrži sve željene 
podatke ispravnim redoslijedom, kliknite OK (U redu). 

Podatkovna tablica sada sadrži podatke i redoslijed stupaca koji ste 
upravo odabrali.

Pomo u potvrdnih okvira odaberite vrstu podataka koje želite uvrstiti u podatkovnu 
tablicu. Koristite strelice prema gore i dolje da biste poredali stupce.

Strelice za
 gore i dolje
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Radni prostor Profile 
(Profil) 4
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 24
• Dodavanje novih profila: stranica 25
• Ure ivanje profila bolesnika: stranica 25
• Brisanje podataka o bolesniku iz sustava: stranica 25
• Povezivanje sa sustavom CareLink Personal 

(nije obavezno): stranica 26

Profil je nešto poput po etne stranice medicinskog kartona. On sadrži 
podatke o bolesniku, kao što je ime i datum ro enja. Profil je potreban 
za prikupljanje podataka iz ure aja i korištenje u izvješ ima o terapiji.

Radni prostor Profile (Profil) ujedno omogu uje povezivanje 
s bolesnikovim ra unom u softveru CareLink Personal. Nakon 
uspostave veze možete u bilo kojem trenutku dohvatiti podatke 
o bolesniku pohranjene u sustavu CareLink Personal, a bolesnik 
ne mora biti prisutan.

Prije po etka

Možda poželite prilagoditi profile bolesnika da bi sadržavali samo 
onu vrstu podataka koju želite prikupiti. Dodatne informacije potražite 
u odjeljku Preference profila bolesnika, na stranici 20.

Potrebno je i korisni ko ime i lozinka da biste postavili vezu s bolesnikovim 
ra unom u sustavu CareLink Personal. Bolesnik mora biti prisutan da 
bi vam pružio te podatke.



Korisni ki priru nik za CareLink™ Pro    Radni prostor Profile (Profil)      25

Dodavanje novih profila

Svaki put kada dodate bolesnika u sustav CareLink Pro, morate prvo 
ispuniti profil za njega. 

1 Odaberite File > New Patient (Datoteka > Novi bolesnik) ili kliknite 
gumb ADD PATIENT (Dodaj bolesnika). 

Prikazan je radni prostor Profile (Profil) (pogledajte primjer na str. 11).

NAPOMENA: da biste
dodali ili promijenili

polja u profilu
bolesnika, kliknite
>> customize fields

(za prilagodbu polja).
Pogledajte odjeljak

Preference profila
bolesnika, na stranici 20.

2 Ispunite polja u odjeljku Patient Profile (Profil bolesnika). 

3 Kliknite SAVE (Spremi).

Profil novog bolesnika dodaje se u bazu podataka sustava CareLink Pro. 
Prikazuje se poruka kojom se potvr uje da je profil spremljen.

Ako obavezno polje nije ispunjeno kada spremate profil bolesnika, 
pokraj tog polja prikazuje se poruka. Spremanje profila ne e vam biti 
dopušteno sve dok ne izvršite unos u polje.

Ure ivanje profila bolesnika

1 Provjerite je li radni prostor Profile (Profil) bolesnika otvoren.

2 Kliknite EDIT (Uredi).

3 Uredite podatke u odjeljku Patient Profile (Profil bolesnika).

4 Kliknite SAVE (Spremi).

Prikazuje se poruka kojom se potvr uje da je profil spremljen.

Brisanje podataka o bolesniku iz sustava         

1 Provjerite je li radni prostor Profile (Profil) bolesnika otvoren. 

2 Provjerite je li rije  o bolesniku kojeg želite izbrisati. Brisanjem profila 
bolesnika ujedno ete ukloniti sve njegove podatke iz baze podataka 
sustava CareLink Pro. Taj postupak nije mogu e poništiti.

3 Kliknite >> delete patient record (izbriši zapis o bolesniku) iznad 
odjeljka za sinkronizaciju profila.

Prikazuje se poruka s upozorenjem da e se brisanjem zapisa izbrisati 
svi podaci o bolesniku. 

4 Kliknite YES (Da) da biste izbrisali zapis o bolesniku.

Gumb Add Patient
(Dodaj bolesnika)
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Povezivanje sa sustavom CareLink Personal 
(nije obavezno)         

Uz dopuštenje bolesnika možete uspostaviti vezu s njegovim ra unom 
u sustavu CareLink Personal. Taj web-alat bolesnicima omogu uje 
prijenos i pohranu podataka primljenih iz ure aja te sastavljanje 
razli itih izvješ a o terapiji. 

Kada se povežete s bolesnikovim ra unom u sustavu CareLink 
Personal, možete dohvatiti podatke iz ure aja koji su tamo pohranjeni 
radi generiranja izvješ a iz softvera CareLink Pro. Izvješ a se mogu 
generirati u bilo kojem trenutku, ak i izme u posjeta ordinaciji. Uz to 
se i smanjuje potreba za itanjem bolesnikova ure aja u ordinaciji.

Ako bolesnik još nema ra un za CareLink Personal, možete mu poslati 
poruku e-pošte i pozvati ga da otvori ra un. 

Povezivanje s postoje im ra unom  

NAPOMENA: bolesnik
mora biti prisutan radi
dovršenja ovih koraka.

1 Morate biti povezani s internetom.

2 Otvorite radni prostor Profile (Profil) za bolesnika. 

3 Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

4 Kliknite LINK TO EXISTING ACCOUNT (Povezivanje s postoje im 
ra unom). 

Prikazat e se zaslon za prijavu na sustav CareLink Personal.

5 Bolesnik sada mora:

a. upisati svoje korisni ko ime i lozinku
b. kliknuti SIGN IN (Prijava) 
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Prikazuje se stranica za dopušteni pristup na temelju postavki prijave 
bolesnika za jezik i regiju.

6 Bolesnik sada mora:

a. pro itati uvjete upotrebe
b. klikom potvrditi okvir pokraj teksta I agree to the Terms of Use 

above… (Slažem se s gore navedenim uvjetima upotrebe…) 
c. kliknuti GRANT ACCESS (Dopusti pristup)
d. obavijestiti vas kada se pojavi stranica sa zahvalom
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Možete ispisati uvjete upotrebe za bolesnika klikom na gumb PRINT (Ispis).

Sada ste povezani s bolesnikovim ra unom u sustavu CareLink 
Personal. Pogledajte odjeljak Primanje podataka iz povezanog ra una, 
na stranici 30.

Slanje pozivnice e-poštom           

Da biste bolesniku poslali e-poštu s pozivnicom za otvaranje ra una za 
CareLink Personal, slijedite ove korake:

1 Otvorite radni prostor Profile (Profil) za bolesnika. 

2 Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

3 Kliknite SEND E-MAIL INVITATION TO PATIENT (Pošalji bolesniku 
pozivnicu e-poštom).
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4 Provjerite jesu li polja Patient Name (Ime bolesnika), Email (E-pošta) 
i Language (Jezik) ispravno ispunjena.

5 Kliknite SEND (Pošalji). 

U podru ju sa statusom profila bolesnika potvr uje se slanje e-pošte.

Prekid veze bolesnikova ra una u sustavu CareLink Personal 
sa softverom CareLink Pro

Možete prekinuti vezu bolesnikova ra una u sustavu CareLink 
Personal sa softverom CareLink Pro. Ta je mogu nost dostupna tek 
nakon uspostavljanja veze. Nakon prekida veze CareLink Pro više ne 
može dohva ati bolesnikove podatke iz sustava CareLink Personal. 
To ne utje e na osobnu upotrebu ra una u sustavu CareLink Personal 
od strane bolesnika.

1 Otvorite zapis o bolesniku i pristupite radnom prostoru Profile (Profil).

2 Kliknite UNLINK ACCOUNT (Prekini vezu s ra unom).

3 Kliknite Yes (Da) u poruci za potvrdu. Osobni profil bolesnika više nije 
povezan sa softverom CareLink Pro.

Status se mijenja u »Not linked« (Nije povezan), a prikazuju se gumbi 
LINK TO EXISTING ACCOUNT (Povezivanje s postoje im ra unom) 
i SEND E-MAIL INVITATION TO PATIENT (Pošalji bolesniku pozivnicu 
e-poštom).
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Primanje podataka iz povezanog ra una              

Ako ste povezani s bolesnikovim ra unom u sustavu CareLink 
Personal, svi novi podaci iz ra una automatski se šalju svaki put kada 
otvorite profil bolesnika u softveru CareLink Pro. 

NAPOMENA: da biste
bili sigurni da e se to

dogoditi, idite na
Tools > Options >

General, (Alati >
Mogu nosti > Op enito)
i provjerite je li uz okvir

»Synchronize with
Medtronic CareLink

Personal« (Sinkronizacija
sa softverom Medtronic

CareLink Personal)
stavljena kva ica.

Slijedite ove korake da biste preuzeli bolesnikove podatke iz sustava 
CareLink Personal u bilo kojem trenutku nakon otvaranja profila 
bolesnika:

1 Provjerite je li otvoren radni prostor Profile za bolesnika te jeste li 
povezani s internetom.

2 Odaberite Tools > Synchronize Patient Data (Alati > Sinkroniziraj 
podatke o bolesniku).

Ikona za sinkronizaciju na kartici bolesnika po inje se okretati. Kada 
se ikona zaustavi, postupak je dovršen.

NAPOMENA: ako
bolesnik više ne želi

dijeliti svoje CareLink
Personal podatke, tu

zna ajku može isklju iti
na izborniku OPTIONS
(Mogu nosti). O tome

e vas se obavijestiti
porukom.

3 Svi dodatni podaci dohva eni iz sustava CareLink Personal bit e
vidljivi u izvješ ima o bolesniku. 

Ikona za sinkronizaciju
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Postavljanje hardvera 5
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 31
• Povezivanje ure aja: stranica 32

U ovom se poglavlju nalaze dijagrami koji pokazuju kako postaviti 
bolesnikov ure aj da bi ra unalo moglo s njega pro itati podatke.

Da biste mogli itati podatke izravno s bolesnikova ure aja, morate 
ga imati kod sebe. No umjesto izravnog o itavanja ure aja podatke 
s ure aja možete preuzeti i s bolesnikova ra una u sustavu 

CareLink™ Personal.   

Prije po etka

Da biste podatke o itavali izravno s ure aja, morate imati bolesnikov 
ure aj kod sebe, kao i kabele ili druge komunikacijske ure aje potrebne 
za slanje podataka na ra unalo.
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Povezivanje ure aja

NAPOMENA: dodatne
pojedinosti možete

prona i u uputama koje
CareLink™ Pro prikazuje

dok o itavate ure aje.

Prou ite pregledni dijagram da biste stekli ideju o tome kako postaviti 
ure aje radi komunikacije s ra unalom. Dijagrami koji slijede ilustriraju 
posebne aspekte komunikacije ure aja. 

NAPOMENA: ovaj
primjer prikazuje kako

se CareLink USB koristi
za komunikaciju izme u

pumpe i ra unala.

Pregled postavljanja hardvera               

TM

CareLinkUSB

CareLink USB

Osobno 
ra unalo

Pumpa Paradigm
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Dijagrami hardverskih veza                                    

                      

Veze s osobnim ra unalom

USB
priklju nica

Serijska
priklju nica
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Povežite sa
serijskom

priklju nicom
na osobnom

ra unalu

ComLink za pumpu serije Paradigm

Dodatne komponente

Com-Station za pumpe MiniMed 508 i za prolaz mjera a
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Radni prostor Devices 
(Ure aji) 6
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 36
• Dodavanje ure aja: stranica 36
• Aktivacija i deaktivacija ure aja: stranica 41 
• itanje podataka iz ure aja: stranica 43

Podaci koje su vam potrebni za itanje bolesnikova ure aja (marka, 
model, serijski broj itd.) pohranjeni su u radnom prostoru Devices (Ure aji). 
Zato ih ne morate navoditi prilikom svakog itanja podataka s ure aja. 

Ure aji u radnom prostoru Devices (Ure aji) pohranjeni su na jednom 
od dva popisa – Active Devices (Aktivni ure aji) ili Inactive Devices
(Neaktivni ure aji). Kada dodate ure aj, on se automatski smješta na 
popis Active Devices (Aktivni ure aji). Možete itati samo podatke 
s ure aja prikazanih na popisu Active Devices (Aktivni ure aji). Na tom 
e se popisu vjerojatno nalaziti ure aji koje bolesnik trenutno koristi. 

Ostali ure aji, koji pripadaju bolesniku, no trenutno se ne koriste, mogu 
se pohraniti na popisu Inactive Devices (Neaktivni ure aji). Na taj na in
podaci ostaju zapisani. Te je ure aje mogu e u initi aktivnima u bilo 
kojem trenutku.
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Prije po etka

Da biste mogli otvoriti radni prostor Devices (Ure aji) za nekog bolesnika, 
njegov profil mora biti spremljen u sustavu. Pogledajte Poglavlje 4, 
Radni prostor Profile (Profil).

Da biste dodali ure aj ili pro itali podatke izravno s njega, ure aj 
mora uspostaviti komunikaciju s ra unalom. Pogledajte Poglavlje 5, 
Postavljanje hardvera da biste doznali kako postaviti ure aje radi 
komunikacije s ra unalom.

Dodavanje ure aja

Ako ure aj još nije dodan, podatke možete preuzeti s bolesnikova 
ra una u sustavu CareLink Personal. Takvi e se ure aji automatski 
dodati prilikom sinkronizacije podataka izme u sustava CareLink 
Personal i CareLink Pro.

NAPOMENA: može
postojati samo jedna

aktivna pumpa za
jednog bolesnika.
Dodavanjem nove

pumpe postoje u ete
pomaknuti na popis

neaktivnih.

Dodavanje pumpe Medtronic ili monitora Guardian           

1 Provjerite je li ure aj koji dodajete postavljen za komunikaciju 
s ra unalom. (Poglavlje 5, Postavljanje hardvera sadrži opis koraka 
povezivanja.)

2 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient 
Lookup (Traženje bolesnika).

3 Kliknite DEVICES (Ure aji) da biste pristupili radnom prostoru 
Devices (Ure aji) za bolesnika (pogledajte primjer na str. 11).

4 Kliknite ADD DEVICE (Dodaj ure aj).

5 Odaberite Medtronic Pump/Guardian. Prikazuje se arobnjak Add
Medtronic Pump/Guardian (Dodavanje pumpe Medtronic/Guardian).

Gumb DEVICES (Ure aji)
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NAPOMENA: model
pumpe naveden je na

stražnjoj strani pumpe
ili na zaslonu statusa

pumpe.

6 Odaberite gumb mogu nosti da biste odredili koji ure aj dodajete. 

Ako ste odabrali mogu nost MiniMed 508 pump, idite na 9. korak.

7 Kliknite NEXT (Dalje). Prikazuje se stranica Serial Number (Serijski broj).

NAPOMENA: ako ne
unesete ispravan

serijski broj, prikazuje
se poruka o pogrešci.

Pogledajte primjere na
ovoj stranici i provjerite

unosite li ispravne
znakove sa stražnje

strane pumpe. Prema
potrebi ponovno

unesite šest znakova.

8 Primjeri na ovoj stranici olakšat e vam pronalaženje 
šesteroznamenkastog broja na ure aju koji dodajete. (Ako vam je 
potrebna dodatna pomo  da ga prona ete, kliknite >> learn more
(doznajte više)). Upišite šest znakova u polje Device Serial Number
(Serijski broj ure aja).

9 Kliknite NEXT (Dalje). Prikazuje se stranica Communication Options
(Mogu nosti komunikacije) koja izgleda poput sljede e.
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10 Kliknite padaju i izbornik Choose Port (Odabir priklju ka) i odaberite 

priklju ak s kojim se ComLink, Paradigm Link®, CareLink USB ili 
Com-Station povezuje na vašem ra unalu. Ako niste sigurni koji 
priklju ak odabrati, odaberite Auto Detect (or USB) (Automatsko 
otkrivanje (ili USB)). 

11 Kliknite NEXT (Dalje). Prikazuje se stranica Test Connection
(Testiranje veze) koja izgleda poput sljede e.

12 Slijedite upute ure aja i kliknite TEST.

Prikazuje se poruka o tome je li povezivanje bilo uspješno. Ako jest, 
prije ite na sljede i korak. 

NAPOMENA: tim se
testom ne itaju podaci

iz pumpe, ve  se
provjerava ispravnost
komunikacije izme u

pumpe i ra unala.

Ako komunikacija nije ispravna, provjerite je li hardver izme u ure aja
i ra unala ispravno povezan. Tako er kliknite BACK (Natrag) na 
stranicama arobnjaka da biste provjerili jeste li unijeli ispravne 
podatke s ure aja.

13 Kliknite DONE (Dovršeno).

Pumpa se dodaje na bolesnikov popis Active Devices (Aktivni ure aji).
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Dodavanje mjera a            

1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici 
Patient Lookup (Traženje bolesnika).

2 Provjerite komunicira li mjera  koji dodajete s ra unalom. 
(Poglavlje 5, Postavljanje hardvera sadrži opis koraka povezivanja.)

3 Kliknite DEVICES (Ure aji) da biste pristupili radnom prostoru 
Devices (Ure aji) za bolesnika (pogledajte primjer na str. 11).

4 Kliknite gumb ADD DEVICE (Dodavanje ure aja).

5 Odaberite Blood Glucose Meter (Mjera  glukoze u krvi). Prikazuje 
se arobnjak Add Blood Glucose Meter (Dodavanje mjera a glukoze 
u krvi).

6 Kliknite gumb mogu nosti da biste odabrali ispravnu marku mjera a.

7 Kliknite NEXT (Dalje). Prikazuje se stranica Meter Model (Model 
mjera a) (ova se stranica razlikuje ovisno o proizvo a u mjera a).
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8 Kliknite model mjera a koji dodajete da biste ga odabrali. 

9 Kliknite NEXT (Dalje). Prikazuje se stranica Communication Options
(Mogu nosti komunikacije).

NAPOMENA: za odabir
su dostupne samo

valjane mogu nosti za
mjera  koji dodajete.

10 Kliknite padaju i izbornik Choose Port (Odabir priklju ka) i odaberite 

priklju ak s kojim se ComLink, Paradigm Link® ili CareLink USB 
povezuje na vašem ra unalu. Ako niste sigurni koji priklju ak odabrati, 
odaberite Auto Detect (Automatsko otkrivanje). 

11 Kliknite NEXT (Dalje). Prikazuje se stranica Test Connection
(Testiranje veze).
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12 Slijedite upute dane za mjera  i kliknite TEST (Testiraj).

Prikazuje se poruka o tome je li povezivanje bilo uspješno. Ako jest, 
prije ite na sljede i korak. 

Ako komunikacija nije ispravna, provjerite je li hardver izme u ure aja
i ra unala ispravno povezan. Tako er kliknite BACK (Natrag) na 
arobnjaku da biste provjerili jesu li podaci koje ste unijeli ispravni.

13 Kliknite DONE (Dovršeno).

Mjera  se dodaje na bolesnikov popis Active Devices (Aktivni ure aji).

Aktivacija i deaktivacija ure aja

Bolesnikovi se ure aji mogu prema potrebi premještati s popisa Active
Devices (Aktivni ure aji) na popis Inactive Devices (Neaktivni ure aji) 
i obrnuto. Ure aj mora biti aktivan da biste s njega mogli pro itati podatke. 

Možete imati neograni en broj mjera a na popisu Active Devices
(Aktivni ure aji), no samo jednu pumpu. Provjerite želite li deaktivirati 
trenutno aktivnu pumpu prije no što dodate novu.

Deaktivacija ure aja              

1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici 
Patient Lookup (Traženje bolesnika).

2 Kliknite DEVICES (Ure aji) da biste pristupili radnom prostoru 
Devices (Ure aji) za bolesnika.
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NAPOMENA: ure aji
mogu biti navedeni pod
ekvivalentnim nazivom

ure aja. Pogledajte
odjeljak Ekvivalentni
ure aji, na stranici 5.

3 Kliknite >> make this device inactive (deaktiviraj taj ure aj) ispod 
ure aja koji želite deaktivirati.

Ure aj se premješta na popis Inactive Devices (Neaktivni ure aji).

Ponovna aktivacija ure aja               

1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient 
Lookup (Traženje bolesnika).

2 Kliknite DEVICES (Ure aji). Prikazuje se radni prostor Devices
(Ure aji) za bolesnika.

3 Kliknite >> activate this device (aktiviraj taj ure aj) ispod ure aja koji 
želite aktivirati.

Ure aj se premješta na popis Active Devices (Aktivni ure aji).

Brisanje ure aja             

Slijede i ove korake izbrisat ete ure aj i njegove podatke iz radnog 
prostora Devices (Ure aji) i softvera CareLink Pro:

1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient 
Lookup (Traženje bolesnika).

2 Kliknite DEVICES (Ure aji) da biste pristupili radnom prostoru 
Devices (Ure aji) za bolesnika.

3 Provjerite nalazi li se ure aj na popisu Inactive Devices (Neaktivni 
ure aji). Ako to nije slu aj, kliknite >> Inactivate this device
(Deaktiviraj taj ure aj) pod trenutnim unosom.

4 Kliknite >> delete this device (izbriši taj ure aj) ispod ure aja koji 
želite izbrisati.

Prikazuje se poruka s upozorenjem da e ure aj i svi podaci iz njega 
biti uklonjeni iz zapisa o bolesniku.

5 Kliknite YES (Da) da biste izbrisali ure aj.

Ure aj i njegovi podaci uklanjaju se iz radnog prostora Devices
(Ure aji) i iz softvera CareLink Pro. Podaci iz tog ure aja više nisu 
dostupni za korištenje u izvješ ima.
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itanje podataka iz ure aja

Podatke iz ure aja možete dobiti povezivanjem s postoje im
bolesnikovim ra unom u sustavu CareLink Personal. (Pogledajte 
odjeljak Povezivanje sa sustavom CareLink Personal (nije obavezno), 
na stranici 26.) Druga je mogu nost da podatke pro itate izravno 
s ure aja, kao što je opisano u ovom poglavlju. 

CareLink Pro može pro itati podatke iz ure aja bolesnika ako se ure aj
nalazi na popisu Active Devices (Aktivni ure aji) i komunicira s ra unalom. 
Nakon primanja podataka možete ih koristiti za stvaranje izvješ a koja 
olakšavaju procjenu održavanja terapije bolesnika. (Poglavlje 7, Radni 
prostor Reports (Izvješ a) sadrži dodatne informacije o izvješ ima.)

U nastavku su navedene neke vrste informacija koje CareLink Pro 
prikuplja iz inzulinske pumpe tijekom prenošenja:  

• razli ite postavke pumpe, kao što su na in rada za upozorenje, 
glasno a zvu nog signala i prikaz vremena

• isporu ene koli ine bazalnog inzulina
• doga aji i isporu ene koli ine u bolusu
• unose u arobnjaku za bolus
• iznose po etnih ciklusa
• razdoblja prekida
• o itanja senzora za glukozu tijekom vremenskog razdoblja kod pumpi 

sa senzorima

Sustav može prikupiti podatke i iz sustava Guardian REAL-Time, uklju uju i:

• o itanja senzora za glukozu (SG)
• koeficijentne vrijednosti senzora
• kalibracijske imbenike senzora
• markere obroka
• ubrizgavanja inzulina

U sustav je mogu e prenijeti i razne informacije pohranjene u mjera u
glukoze u krvi tijekom o itavanja s ure aja. 

UPOZORENJE: otkažite ili dovršite privremene bazalne ili aktivne boluse i poništite 
eventualno aktivne alarme. Pumpa e se zaustaviti radi o itavanja. Po dovršetku o itavanja 
provjerite je li pumpa nastavila s radom.

OPREZ: nemojte koristiti daljinski upravlja  za pumpu tijekom o itavanja. 

Ako je baterija pumpe slaba, pumpa ne e poslati podatke na ra unalo. Zamijenite bateriju 
ako status baterije upozorava da je slaba.    
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1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient 
Lookup (Traženje bolesnika).

2 Provjerite komunicira li bolesnikov ure aj s ra unalom. (Pogledajte 
Poglavlje 5, Postavljanje hardvera.)

3 Kliknite DEVICES (Ure aji) da biste pristupili radnom prostoru 
Devices (Ure aji) za bolesnika.

NAPOMENA: ure aji
mogu biti navedeni pod
ekvivalentnim nazivom

ure aja. Pogledajte
odjeljak Ekvivalentni
ure aji, na stranici 5.

4 Na popisu Active Devices (Aktivni ure aji) prona ite ure aj s kojeg 
želite dohvatiti podatke i provjerite jesu li podaci u polju Choose port
(Odabir priklju ka) to ni.

– Za pumpe kliknite padaju i izbornik Amount of Data (Koli ina 
podataka) i odaberite koliko podataka iz pumpe želite CareLink Pro 
pro itati.

5 Kliknite pridruženi gumb READ DEVICE ( itanje ure aja).

6 Slijedite upute karakteristi ne za ure aj i kliknite OK (U redu).

7 CareLink Pro prikazuje traku napretka koja se ažurira i prikazuje koliki 
je postotak podataka s ure aja pro itan.

8 Ako kliknete CANCEL (Odustani) tijekom itanja ure aja, prikazuje se 
poruka s upozorenjem da odustajanje od itanja ure aja može dovesti 
do gubitka svih dotad pro itanih podataka. Da biste ponovno pokrenuli 
prenošenje, morate kliknuti gumb READ DEVICE ( itanje ure aja) 
(korak 5).

– Da biste odustali, kliknite YES (Da). 
– Da biste nastavili itati podatke s ure aja, kliknite NO (Ne).

Kada sustav završi itanje podataka s ure aja, vidjet ete poruku 
kojom se potvr uje da je itanje s ure aja dovršeno.

9 Kliknite OK (U redu). 

– Za pumpe slijedite upute za nastavak rada.

Ako CareLink Pro ne može preuzeti podatke s ure aja, daljnje smjernice 
pružit e vam Poglavlje 9, Otklanjanje poteško a.
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Radni prostor Reports 
(Izvješ a) 7
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 46
• Stvaranje izvješ a: stranica 46
• O izvješ ima: stranica 53
• Izvoz podataka: stranica 56

Radni prostor Reports (Izvješ a) u softveru CareLink™ Pro omogu uje 
pretvorbu podataka dobivenih iz ure aja u klini ki korisne informacije. 
Informacije o vrstama izvješ a koje možete stvoriti potražite u odjeljku 
O izvješ ima, na stranici 53.

Izvješ a se mogu generirati na zaslonu, poslati izravno pisa u ili spremiti 
kao TIFF ili PDF datoteke koje možete priložiti izvješ u EMR (Electronic 
Medical Record – elektroni ki medicinski zapis). Jednim postupkom 
možete generirati nekoliko vrsta izvješ a.

Podaci prikazani u tim izvješ ima bilježe se s ure aja bolesnika, 
s njihovog ra una u sustavu CareLink Personal ili oboje. 
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Prije po etka

Ako želite da neko vremensko razdoblje bude vidljivo u izvješ u, morate 
imati podatke s ure aja bolesnika za to vremensko razdoblje. Možda 
ete bolesnikov ure aj morati povezati s ra unalom da biste prije pokretanja 

izvješ a dobili aktualne podatke.

Prije pokretanja izvješ a obavezno pažljivo prou ite korak Verify Report 
Settings (Provjera postavki izvješ a). Na tom mjestu možete precizno 
ugoditi izvješ e da bi odražavalo podatke o bolesniku koje želite.

Stvaranje izvješ a

U sljede im su odjeljcima opisani koraci potrebni za stvaranje jednog ili 
više izvješ a.

Otvaranje radnog prostora Reports (Izvješ a)      

1 Kliknite karticu bolesnika ili gumb OPEN PATIENT (Otvori bolesnika) 
pa dvokliknite njegovo ime.

Prikazuje se radni prostor Reports (Izvješ a) (pogledajte primjer 
na str. 11).

NAPOMENA: da biste
provjerili imate li

najnovije podatke
s ure aja iz bolesnikova

ra una u sustavu
CareLink Personal,

kliknite SYNC DATA
(Sinkroniziraj podatke).

Odabir razdoblja izvješ ivanja        

1 Da biste promijenili vremensko razdoblje obuhva eno izvješ em,
kliknite padaju i izbornik Duration (Trajanje) i odaberite vrijeme. 
(Maksimalno je trajanje 12 tjedana.)

2 Datumi po etka i kraja automatski se postavljaju, osim ako ne 
odaberete mogu nost custom date range (prilago eni raspon 
datuma).

NAPOMENA: ako
odaberete raspon

datuma koji je ve i od
dopuštenog, prikazuje
se poruka o pogrešci.
Prilagodite trajanje ili

datume.

Ako želite prilago eni raspon datuma, kliknite padaju e izbornike 
From (Od) ili Through (Do) i odaberite željeni mjesec, datum ili godinu. 

Gumb Open Patient
(Otvori bolesnika)
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Kalendar s podacima

U podru ju podatkovnog kalendara u radnom prostoru Reports
(Izvješ a) prikazuje se prozor s podacima izvješ a za tri mjeseca. 
U njemu su popisani ure aji te je prikazano koliko podataka iz ure aja
odabrana tri mjeseca obuhva aju. Prikazano je i trajanje razdoblja 
izvješ ivanja za odabrana tri mjeseca. 

Ako se podaci s ure aja preklapaju s razdobljem izvješ ivanja, to 
zna i da imate podatke za prikazano razdoblje izvješ ivanja ili za 
jedan njegov dio.

Podru je podatkovnog kalendara prvo prikazuje tri zadnja mjeseca. 
Da biste vidjeli druge mjesece, kliknite tipke sa strelicama s lijeve ili 
desne strane prikazanih mjeseci.

Podaci iz ure aja
Razdoblje izvješ ivanja

Kalendar s podacima
Mjeseci

Preklapanje podataka s ure aja
s razdobljem izvješ ivanja

Tipke sa
strelicama
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Odabir izvora podataka koje želite obuhvatiti       

1 Ako bolesnik koristi mjera  razine glukoze u krvi povezan s pumpom, 
kliknite da biste odabrali jednu od sljede ih mogu nosti za korištenje 
podataka mjera a o razini glukoze u krvi u izvješ u:

– in the pump (u pumpi): prednosti su te mogu nosti to što morate 
pro itati podatke samo s bolesnikove pumpe, pumpa ozna ava 
vrijeme na o itanjima razine glukoze u krvi, a o itanja su izravno 
povezana s izra unima arobnjaka za bolus. No ako postoje 
poteško e u komunikaciji izme u pumpe i povezanog mjera a,
u tom razdoblju možda ne e biti prijavljena o itanja razine glukoze 
u krvi. Osim toga, ako je model pumpe MiniMed Paradigm koju 
koristite stariji od 522/722, o itanja razine glukoze u krvi iz 
izra una arobnjaka za bolus na koja niste reagirali ne e u i
u izvješ e.

– in the linke meter(s) (u povezanom mjera u): prednost je te 
mogu nosti prijava svih o itanja pohranjenih u povezanom 
mjera u. Nedostatak je to što ste radi korelacije podataka iz 
mjera a i pumpe prethodno morali provjeriti jesu li pumpa 
i mjera me usobno sinkronizirani. Tako er morate zasebno 
pro itati podatke iz pumpe i povezanog mjera a.

2 Da biste podatke iz ure aja dodali u izvješ a, potvrdite okvir pored 
relevantnog ure aja.

Ne možete dodati ure aje koji su bili isklju eni zbog vašeg odabira 
u 1. koraku. Da biste to promijenili, odaberite drugu mogu nost
povezanog mjera a.

3 Da biste podatke iz ure aja izostavili iz izvješ a, poništite potvrdni 
okvir pokraj relevantnog ure aja.

Ne možete poništiti potvrdne okvire uz mogu nost koju ste odabrali 
u 1. koraku. Da biste to promijenili, odaberite drugu mogu nost
povezanog mjera a.

Provjera ima li podataka u ure aju        

1 Pogledajte podru je kalendara s podacima u radnom prostoru 
Reports (Izvješ a) da biste vidjeli preklapa li se razdoblje izvješ ivanja 
s podacima iz ure aja (pogledajte primjer na str. 47).

2 Ako se trake preklapaju tijekom cijelog razdoblja izvješ ivanja, 
raspolažete podacima za izvješ e. Možete kliknuti NEXT (Dalje) 
i prije i na odjeljak Provjera postavki izvješ a, na stranici 50.
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3 Ako se trake ne preklapaju ili ako nema dovoljno preklapanja, možete 
odabrati jednu od sljede ih mogu nosti:

– prilagodite razdoblje izvješ ivanja (pogledajte odjeljak Odabir
razdoblja izvješ ivanja, na stranici 46)

– preuzmite dodatne podatke iz ure aja (pogledajte odjeljak 
Preuzimanje dodatnih podataka iz ure aja, na stranici 49)

Preuzimanje dodatnih podataka iz ure aja         

1 Da biste preuzeli više podataka s ure aja, kliknite gumb READ 
DEVICE ( itanje ure aja) pridružen ure aju.

Prikazuje se traka Read Device ( itanje ure aja).

UPOZORENJE: otkažite ili dovršite privremene bazalne ili aktivne boluse i poništite 
eventualno aktivne alarme. Pumpa e se zaustaviti radi o itavanja. Po dovršetku o itavanja 
provjerite je li pumpa nastavila s radom.

OPREZ: nemojte koristiti daljinski upravlja  za pumpu tijekom o itavanja. 

Ako je baterija pumpe slaba, pumpa ne e poslati podatke na ra unalo. Zamijenite bateriju 
ako zaslon sa statusom baterije upozorava na to da je slaba.    

2 Provjerite jesu li podaci u polju Choose port (Odabir priklju ka) ispravni 
za taj ure aj.

Da biste promijenili tu postavku, kliknite padaju i izbornik za to polje 
i odaberite neku drugu postavku.

3 Provjerite je li ure aj povezan s vašim ra unalom. 

4 Ako je ure aj pumpa, možete odrediti koliko ete podataka iz nje 
preuzeti. Kliknite padaju i izbornik Amount of Data (Koli ina podataka) 
i odaberite koli inu.

Traka READ DEVICE ( itanje ure aja)

Gumb READ DEVICE 
( itanje ure aja)
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NAPOMENA: ako
odaberete All available

data (Svi dostupni
podaci), sustav e

pro itati sve podatke
u pumpi. Time ete

prebrisati sve postoje e
udvostru ene podatke

u sustavu.

5 Kliknite READ DEVICE ( itanje ure aja). Obavezno pažljivo pro itajte 
prikazanu poruku jer su u njoj navedene specifi ne upute za o itavanje
pumpe.

6 Slijedite upute i kliknite OK (U redu). 

Prikazuje se traka napretka pri itanju s ure aja.

U bilo kojem trenutku možete odustati od itanja klikom 
na CANCEL (Odustani).

Po dovršetku itanja prikazuje se poruka s potvrdom.

7 Kliknite OK (U redu).

Podaci s ure aja sada su vidljivi na kalendaru s podacima.

8 Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports (Izvješ a).

Prikazuje se korak Verify Report Settings (Provjera postavki izvješ a). 
On omogu uje provjeru ispravnosti postavki za tog bolesnika prije 
pokretanja izvješ a.

Provjera postavki izvješ a           

1 Provjerite jesu li postavke za vrijednost Glucose Target (Ciljana 
glukoza) u skladu sa željenim postavkama. Upišite te vrijednosti ili 
kliknite strelice prema gore ili dolje u poljima Low (Donja) i High
(Gornja) da biste pove ali ili smanjili vrijednosti.

Vremenska
crta

Vrijeme obroka 

Polja za ure ivanje razdoblja obroka

Razdoblja odlaska na spavanje i bu enja
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NAPOMENA: možete
odrediti do pet

razdoblja obroka.
Zadani su doru ak,

ru ak i ve era.

2 Da biste dodali novo razdoblje obroka, kliknite ADD MEAL (Dodaj 
obrok). Da biste uredili postoje e razdoblje obroka, kliknite bilo gdje 
unutar jednog od razdoblja obroka na vremenskoj crti.

Aktivira se ure iva  razdoblja obroka koji se nalazi ispod vremenske crte.

3 Unesite tekst ili kliknite strelice da biste odabrali željene postavke.

NAPOMENA: ako te
postavke želite koristiti

samo za taj obrok,
poništite potvrdni okvir
Use these parameters for
all of this patient’s meals

(Koristi te parametre za
sve obroke ovog

bolesnika).

– Meal Name (Naziv obroka): naziv koji želite dodijeliti razdoblju 
obroka

– Meal Time Period (Vrijeme obroka): sati izme u kojih se obrok 
konzumira

– Pre-Meal BG Target (mg/dL or mmol/L) (Raspon ciljane glukoze 
u krvi prije obroka (mg/dL ili mmol/L)): donje i gornje vrijednosti 
ciljanog raspona glukoze u krvi bolesnika prije obroka

– Pre-Meal Analysis Period vremensko razdoblje u kojemu e
se analizirati glukoza prije po etka obroka. O itanja glukoze 
zabilježena tijekom tog razdoblja koriste se za detaljnu analizu 
izvješ a

– Post-Meal BG Target (mg/dL or mmol/L) (Raspon ciljane 
glukoze u krvi poslije obroka (mg/dL ili mmol/L)): donje i gornje 
vrijednosti ciljanog raspona glukoze u krvi bolesnika poslije obroka

– Post-Meal Analysis Period vremensko razdoblje u kojemu e se 
analizirati glukoza nakon obroka. O itanja glukoze zabilježena 
tijekom tog razdoblja koriste se za detaljnu analizu izvješ a

NAPOMENA: razdoblja
obroka ne smiju se

preklapati, no po etne
i završne crte smiju

me usobno grani iti.
Razdoblja obroka

moraju trajati barem
60 minuta.

Možete promijeniti duljinu postoje eg razdoblja obroka ili razdoblja 
bu enja i odlaska na spavanje tako da kliknete ru ice po etka ili 
završetka te ih povu ete i ispustite duž vremenske crte. 

Odaberite ru icu po etka ili završetka te je povucite i ispustite duž 
vremenske crte

Vremenska crta

Oznake o itanja mjera a
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4 Da biste postavke za taj obrok koristili za sve druge obroke bolesnika, 
provjerite je li potvr en okvir Use these parameters for all of this 
patient’s meals (Koristi te parametre za sve obroke ovog bolesnika).

5 Nakon što stvorite ili uredite razdoblje obroka, kliknite SAVE (Spremi).

6 Da biste uklonili razdoblje obroka, kliknite DELETE MEAL (Izbriši obrok). 
Kliknite DELETE (Izbriši) kada se od vas zatraži da potvrdite odluku.

7 CareLink Pro može zapamtiti postavke za tog bolesnika sljede i put 
kada pokrenete izvješ e za njega. Da biste spremili postavke za tog 
bolesnika, kliknite SAVE SETTINGS (Spremi postavke).

8 Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports (Izvješ a).

Time pokre ete korak Select and Generate Reports (Odabir 
i generiranje izvješ a). Taj korak pruža popis vrsta izvješ a
i podatkovnu tablicu uz koju ete lakše odlu iti ho ete li uvrstiti ili 
izostaviti odre ene dane s podacima iz izvješ a Daily Detail
(Dnevne pojedinosti). 

9 Da biste ispisali podatke sa zaslona, kliknite ikonu za PRINT (Ispis).

NAPOMENA: da biste
izmijenili prikaz

podatkovne tablice,
kliknite >> customize

columns (prilagodi
stupce). Pogledajte
odjeljak Preference

generiranja izvješ a, na
stranici 22.

Odabir razdoblja izvješ ivanja i datuma uvrštavanja           

1 Potvrdite okvir pokraj izvješ a koje želite uvrstiti u skup izvješ a.

2 Ako su tijekom tog razdoblja izvješ ivanja podaci s pumpe ili monitora 
Guardian o itani više puta, možda e postojati više snimki ure aja: 

a. Provjerite je li potvr en okvir Device Settings Snapshot (Snimka 
postavki ure aja). 

Podatkovna tablica

Ikona za
ispis
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b. Kliknite padaju u strelicu i odaberite datum i vrijeme snimke. 
– pumpe: odaberite snimku s pumpe bolesnika
– Guardian: odaberite snimku s bolesnikova monitora Guardian 

Ako je bilo koje od polja zatamnjeno, nema dostupnih snimki tijekom 
razdoblja izvješ ivanja.

3 Prolistajte podatkovnu tablicu da biste pregledali dostupne podatke 
iz izvješ a Daily Detail (Dnevne pojedinosti). 

– Možete sortirati podatke u svakom stupcu. Kliknite naslov stupca 
da biste sortirali podatke uzlaznim redoslijedom. Ponovno kliknite 
naslov da biste sortirali podatke silaznim redoslijedom.

NAPOMENA: ako nema
podataka za odre eni
datum, taj datum nije

mogu e odabrati.

4 Potvrdite okvir u recima podatkovne tablice za svaki datum za koji 
želite izvješ e Daily Detail (Dnevne pojedinosti). 

– Da biste jednim klikom uvrstili ili izostavili sve datume izvješ a
Daily Detail (Dnevne pojedinosti), potvrdite ili poništite okvir pri 
vrhu stupca s potvrdnim okvirima podatkovne tablice.

Generiranje izvješ a                                   

1 Nakon što provjerite odabire izvješ a, kliknite GENERATE REPORTS 
(Generiranje izvješ a) pri vrhu radnog prostora Reports (Izvješ a).

Prikazuje se popis mogu nosti.

2 Odaberite mogu nost za pretpregled, ispis ili spremanje izvješ a.

Ako ste odabrali Preview (Pretpregled), prikazuje se prozor Report
Preview (Pretpregled izvješ a).

3 Kliknite tipke sa strelicama da biste se kretali kroz izvješ a koja 
sadrže više stranica.

4 Kliknite jedan od ostalih gumba pri vrhu prozora Report Preview
(Pretpregled izvješ a) da biste spremili ili ispisali izvješ e.

5 Da biste zatvorili taj prozor, kliknite gumb CLOSE (Zatvori) u gornjem 
desnom kutu prozora.

O izvješ ima         

Ovaj odjeljak sadrži opis svakog izvješ a. U referentnom vodi u za 
izvješ a navedene su dodatne pojedinosti o komponentama izvješ a, 

Gumb CLOSE preview
(Zatvori pretpregled)
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kao i uzorci izvješ a. Referentnom vodi u za izvješ a možete pristupiti 
putem softvera CareLink Pro:

1 Help > View Report Reference Guide (PDF) (Pomo  > Prikaz 
referentnog vodi a za izvješ a (PDF)). 

2 Odaberite jezik referentnog vodi a za izvješ a.

Izvješ a softvera CareLink Pro imaju ove zajedni ke elemente: 

• Report header (Zaglavlje izvješ a) – zaglavlje izvješ a sadrži podatke 
za identifikaciju, primjerice naziv izvješ a, ime bolesnika i izvor 
podataka

• Carbohydrates and blood glucose levels (Razine ugljikohidrata 
i glukoze u krvi) – u grafikonima i dijagramima jedinice ugljikohidrata 
prikazane su kurzivom, a razine glukoze u krvi podebljano

• Weekend data (Podaci o vikendu) – dani vikenda podebljani su da 
biste ih mogli jednostavno prepoznati

• Legends (Kazalo) – kazalo simbola pojavljuje se pri dnu svakog 
izvješ a. Dok je simbol mogu e koristiti u više izvješ a, kazala su 
jedinstvena za svako izvješ e.

Adherence Report (Izvješ e o pridržavanju propisane terapije)        

U tom su izvješ u prikazani podaci koji opisuju kako se koriste 
inzulinske pumpe i senzori, a opisano je i ponašanje bolesnika 
relevantno za terapiju koju primaju. Izvješ e odgovara na pitanje: »Je li 
bilo dovoljno podataka za to an prikaz na ina na koji bolesnik koristi 
inzulinsku pumpu i senzor (ako je primjenjivo)?«. Ono odgovara i na 
pitanje: »Pridržavaju li se bolesnici terapije prema uputama?«. Izvješ e
uz to daje naznake o tome trebate li razgovarati s bolesnikom 
o njegovu na inu kontrole dijabetesa.

Sensor and Meter Overview Report (Izvješ e o pregledu senzora 
i mjera a)        

Sensor and Meter Overview Report (Izvješ e o pregledu senzora 
i mjera a) pruža grafi ki prikaz dnevnih razina i prosjeka glukoze u krvi 
bolesnika dobivenih iz mjera a, uklju uju i podatke za svaki sat tijekom 
24 sata te njihov odnos s obrocima i spavanjem. Uvršteni su i statisti ki 
podaci o o itanjima razine glukoze u krvi bolesnika i korištenju inzulina. 

Ako su dostupni podaci iz senzora, generira se sli na analiza podataka 
iz senzora kao prva stranica ovog izvješ a. Ako podaci iz senzora nisu 
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dostupni, stranica s analizom podataka mjera a generira se kao prva 
stranica.

Na zadnjoj stranici izvješ a prikazane su dnevne razine i kvaliteta 
kontrole glukoze, ugljikohidrata i inzulina bolesnika. Na svakoj je 
stranici prikazano kako kontrola varira svakog dana tijekom cijelog 
razdoblja izvješ ivanja do najviše 14 dana po stranici.

Logbook Report (Izvješ e zapisnika)        

Izvješ e zapisnika prikazuje podatke o mjera u glukoze, ugljikohidratima 
i inzulinu za svaki dan odabranog razdoblja. Ono sadrži dnevnik doga aja
zabilježenih svakog sata te dnevne prosjeke i ukupne podatke. Svaka 
stranica sadrži podatke za najviše 14 dana. Ako razdoblje izvješ ivanja 
premašuje 14 dana, generiraju se dodatne stranice.

Device Settings Snapshot (Snimka postavki ure aja)        

U ovom se izvješ u prikazuje snimka postavki bolesnikove pumpe ili 
monitora Guardian REAL-Time za odre eni datum i vrijeme. To vam 
može olakšati razumijevanje drugih izvješ a ili jednostavno dokumentirati 
postavke bolesnika. 

Postavke pumpe ili monitora snimaju se samo pri o itavanju ure aja. 
Ako ure aj nije o itan tijekom razdoblja izvješ ivanja, nikakve postavke 
ne e biti dostupne.

Daily Detail Report (Izvješ e s dnevnim pojedinostima)        

U izvješ u s dnevnim pojedinostima prikazani su podaci o razini 
glukoze, koli ini ugljikohidrata i bolesnikovu korištenju inzulina za 
odabrani dan. Za svaki dan koji odaberete iz podatkovne tablice 
generira se zasebno izvješ e.

Izvješ e s dnevnim pojedinostima pruža detaljan uvid u odabrani dan. 
Ono vam omogu uje da se usredoto ite na odre eni dan ako smatrate 
da se tada dogodilo nešto važno za terapiju bolesnika.
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Izvoz podataka

Možete izvesti podatke s ure aja koje je CareLink Pro pribavio 
i pohranio. Tako sve podatke s ure aja bolesnika možete koristiti 
u statistikama ili za stvaranje specijaliziranih izvješ a ili grafikona. 
Datoteku .csv možete uvesti u Microsoft Excel ili neke programe za 
klini ku statistiku te zatim njima dalje upravljati.

Datoteka .csv sadrži podatke u kojima su zabilježene radnje ure aja. 
Navedeni su, primjerice, snimka o itanja mjera a, pumpa koja prima 
vrijednost o itanja mjera a ili promjena bazalnog ritma.

NAPOMENA: to je
napredna zna ajka za

koju morate poznavati
neobra ene podatke

s ure aja. Potrebno je
i dobro poznavanje
softvera u koji ete

uvesti .csv datoteku.

Slijedite ove korake da biste koristili zna ajku izvoza softvera 
CareLink Pro:

1 Kliknite karticu bolesnika ili kliknite gumb OPEN PATIENT 
(Otvori bolesnika) pa dvokliknite njegovo ime.

2 Provjerite je li otvoren radni prostor Reports (Izvješ a).
3 Koristite polje Duration (Trajanje) ili From/Through (Od/Do) da biste 

postavili datume i duljinu izvješ a.
Maksimalno trajanje koje možete odabrati iznosi 12 tjedana.

4 Kliknite vezu export selected data (izvoz odabranih podataka).

Prikazuje se dijaloški okvir Export Data to CSV File (Izvoz podataka 
u CSV datoteku).

5 Da biste promijenili mjesto pohrane .csv datoteke na ra unalu, kliknite 
strelicu s desne strane polja Save in (Spremi u) i odaberite mjesto.

6 Ako želite promijeniti naziv datoteke, upišite ga u okvir File name
(Naziv datoteke).

7 Kliknite SAVE (Spremi).

NAPOMENA: dodatne
informacije o podacima

prikazanima u CSV
datotekama potražite

u odjeljku CSV podaci,
na stranici 68.

Datoteka s nastavkom .csv sada je spremljena na odabranom mjestu 
na vašem ra unalu. Sada možete izvršiti njezin uvoz u bilo koji program 
koji podržava tu vrstu datoteka.

Veza za izvoz 
odabranih podataka
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Administracija sustava 8
Što se nalazi u ovom poglavlju
• Prije po etka: stranica 57
• Primjena ažuriranja softvera: stranica 58
• Stvaranje sigurnosne kopije i povrat baze podataka: stranica 59

Važno je da redovito stvarate sigurnosne kopije baze podataka 

softvera CareLink™ Pro. U bazi podataka pohranjeni su svi sistemski 
podaci akumulirani u zapisima o bolesniku, uklju uju i informacije 
o profilu, podatke dobivene iz ure aja i postavke izvješ a. 

CareLink Pro omogu uje spremanje i povrat kopija baze podataka.

Važno je i da imate najnoviju verziju softvera CareLink Pro. S vremena 
na vrijeme dostupne su ažurirane verzije koje mogu sadržavati važna 
poboljšanja. Možete potražiti ažuriranja ili primiti obavijest kada su 
ažuriranja dostupna.

Prije po etka

Preporu ujemo da uspostavite redoviti raspored prema kojem ete 
stvarati sigurnosne kopije baze podataka. Na taj ete na in osigurati 
redovito stvaranje kopija baze podataka i minimizirati rizik gubitka 
podataka. 

Tijekom stvaranja sigurnosne kopije ili povrata CareLink Pro otkriva 
druge korisnike koji možda koriste softver na drugim ra unalima i nudi 
im priliku da spreme svoj rad. No ipak preporu ujemo da provjerite ima 
li drugih korisnika prije no što pokrenete bilo koji postupak.
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Primjena ažuriranja softvera

Automatsko primanje ažuriranja

Povremeno su dostupna ažuriranja softvera CareLink Pro. Kada se 
prikaže obavijest o ažuriranju, poduzmite slijede e korake da biste 
preuzeli najnovije izdanje softvera.

NAPOMENA: potrebno
je stvoriti sigurnosnu
kopiju baze podataka

prije primjene ažuriranja
softvera. Pogledajte

odjeljak Stvaranje
sigurnosne kopije baze

podataka, na stranici 59.

1 Provjerite je li internetska veza dostupna i aktivna na vašem ra unalu.

2 Kada je ažuriranje za CareLink Pro dostupno, prikazuje se poruka 
o ažuriranju. Nudi se mogu nost preuzimanja ažuriranja.

3 Kliknite DOWNLOAD (Preuzimanje). (Ako kliknete CANCEL (Odustani), 
obavijest o ažuriranju e se zatvoriti. Ažuriranje možete preuzeti kasnije.)

Prikazuje se poruka upozorenja u kojoj se preporu uje da stvorite 
sigurnosnu kopiju baze podataka.

4 Kliknite YES (Da) da biste stvorili sigurnosnu kopiju baze podataka 
(opis tog postupka potražite u odjeljku Stvaranje sigurnosne kopije 
baze podataka, na stranici 59). Kliknite NE ako ne želite stvoriti 
sigurnosnu kopiju baze podataka.

Prikazat e se poruka kojom se potvr uje da je nova verzija softvera 
CareLink Pro preuzeta.

5 Da biste po eli koristiti najnoviju verziju softvera CareLink Pro, kliknite 
YES (Da) da biste zatvorili i ponovno otvorili softver. Kliknite NO (Ne) 
ako ne želite odmah ponovno pokrenuti CareLink Pro.

Isklju ivanje automatskih ažuriranja

Ako ne želite primati automatske obavijesti o ažuriranjima za CareLink 
Pro, slijedite ove korake:

1 Odaberite Tools > Options (Alati > Mogu nosti).

2 Kliknite karticu General (Op enito).

3 U odjeljku Communications (Komunikacija), poništite potvrdni okvir 
Automatically check for software updates (Automatski provjeri ima li 
ažuriranja softvera).
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Ru na provjera dostupnosti ažuriranja

U svakom trenutku možete ru no provjeriti jesu li dostupna ažuriranja 
za CareLink Pro.

NAPOMENA: potrebno
je stvoriti sigurnosnu
kopiju baze podataka

prije primjene ažuriranja
softvera. Pogledajte

odjeljak Stvaranje
sigurnosne kopije baze

podataka, na stranici 59.

1 Provjerite je li internetska veza dostupna i aktivna na vašem ra unalu.

2 Odaberite Tools > Check for Software Updates (Alati > Provjeri ima 
li ažuriranja softvera).

3 Ako trenutno nema dostupnih ažuriranja, primit ete poruku. Ako 
je ažuriranje dostupno, prikazuje se poruka o ažuriranju softvera 
CareLink Pro. 

4 Slijedite postupak u odjeljku Automatsko primanje ažuriranja, 
na stranici 58.

Stvaranje sigurnosne kopije i povrat baze podataka

Stvaranje sigurnosne kopije baze podataka     

Sljede i koraci opisuju sigurnosno kopiranje trenutne baze podataka na 
mjesto koje odaberete.

1 Provjerite jesu li svi zapisi o bolesnicima zatvoreni.

2 Odaberite Tools > Backup Database (Alati > Sigurnosno kopiranje 
baze podataka).

NAPOMENA:
sigurnosne kopije baze

podataka mogu se
spremiti na mrežni

pogon ili na izmjenjivi
medij za pohranu (DVD,

CD, USB pogon itd.).

3 Da biste spremili sigurnosnu kopiju na neko drugo mjesto na vašem 
ra unalu, kliknite strelicu s desne strane polja Save in (Spremi u) 
i odaberite novo mjesto.

4 Ako želite promijeniti naziv datoteke sigurnosne kopije, upišite ga 
u okvir File name (Naziv datoteke).

5 Kliknite SAVE (Spremi). Traka napretka prikazuje se tijekom spremanja 
baze podataka.

Kada je sigurnosno kopiranje dovršeno, prikazuje se poruka.

6 Kliknite OK (U redu) da biste zatvorili poruku.

Vra anje baze podataka         

Možda je potrebno zamijeniti trenutnu bazu podataka ako joj više nije 
mogu e pristupiti ili je više nije mogu e koristiti.

OPREZ: kada izvršite povrat sa sigurnosnom kopijom, gubite sve nove podatke stvorene 
od trenutka kada ste na inili odabranu sigurnosnu kopiju.
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Sljede i koraci opisuju odabir sigurnosne kopije kojom ete zamijeniti 
trenutnu bazu podataka.

1 Provjerite jesu li svi zapisi o bolesnicima zatvoreni.

2 Odaberite Tools > Restore Database (Alati > Povrat baze podataka). 

3 Odaberite datoteku sigurnosne kopije kojom želite zamijeniti trenutnu 
bazu podataka (obi no je to najnovija).

4 Kliknite OPEN (Otvori). Prikazuje se poruka s upozorenjem. Kliknite 
OK (U redu).

5 Traka napretka prikazuje se tijekom povrata baze podataka.

Po završetku vra anja baze podataka prikazuje se poruka.

6 Kliknite OK (U redu) da biste zatvorili poruku.

Ako sustav nije dostupan                

Ako pokušate pokrenuti sustav dok drugi korisnik izvršava sigurnosno 
kopiranje ili vra anje, prikazat e se poruka s obavijesti da sustav nije 
dostupan. Ne ete mo i pristupiti sustavu dok se zadatak ne dovrši.

U inite nešto od navedenog:

• Pri ekajte da postupak završi i da sustav postane dostupan.
• Kliknite CANCEL (Odustani) da biste izašli iz programa i pokušali 

ponovno kasnije.
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Otklanjanje poteško a 9
Što se nalazi u ovom poglavlju
• Op e pogreške pri korištenju programa: stranica 61
• Pogreška pri itanju ure aja: stranica 62
• Pogreške pri stvaranju izvješ a: stranica 64
• Pogreške prilikom sigurnosnog kopiranja i vra anja: stranica 65
• Deinstalacija softvera: stranica 65

Ovo poglavlje olakšat e vam rješavanje problema do kojih može do i

tijekom korištenja softvera CareLink™ Pro. Ono sadrži i upute za 
deinstalaciju softvera CareLink Pro ako to postane nužno.

Op e pogreške pri korištenju programa

Ovlasti za preuzimanje nadogradnji softvera putem interneta

Ako pokušate preuzeti nadogradnju softvera putem interneta, mogli 
biste primiti poruku da nemate dovoljne ovlasti za to. Morate imati 
administrativne ovlasti da biste preuzimali nadogradnje za CareLink Pro.

1 Zatvorite CareLink Pro i ponovno pokrenite ra unalni sustav. 

2 Neka se osoba s administrativnim ovlastima prijavi na ra unalo.

3 Slijedite upute u odjeljku Primjena ažuriranja softvera, na stranici 58.
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Ne postoji veza s bazom podataka

Poruka o pogrešci koja vas upozorava da niste povezani s bazom 
podataka upu uje na nešto od navedenog:

• Baza podataka je premještena. Baza podataka mora se nalaziti na 
mjestu koje ste odabrali tijekom instalacije softvera CareLink Pro. Ako 
je premještena, morate je vratiti na mjesto odabrano tijekom instalacije.

• Niste povezani s mrežnim pogonom na kojem se baza podataka 
nalazi. Ako se baza podataka nalazi na mrežnom pogonu, na mreži se 
povremeno mogu pojaviti problemi koji mogu sprije iti pristupanje 
pogonu. Obratite se odjelu za ra unalnu podršku da biste dobili pomo
za ponovno povezivanje s mrežnim pogonom na kojem se nalazi baza 
podataka. 

Zaboravili ste lozinku ambulante za CareLink Pro

Ako se nitko ne može sjetiti lozinke koju vaša ambulanta koristi za 
prijavu u CareLink Pro, morate ponovno instalirati softver CareLink Pro 
i stvoriti novu bazu podataka. Kada ponovno instalirate softver, ne ete 
mo i pristupiti informacijama o bolesniku koje su se nalazile u prijašnjoj 
bazi podataka. Lozinku koju stvorite tijekom nove instalacije pohranite 
negdje u uredu da ne biste izgubili budu e podatke. 

Pogreška pri itanju ure aja

Pogreška pri itanju ure aja Objašnjenje

The selected serial port could 
not be opened. Another 
operation might be in 
progress on that port. Please 
wait until the port is available, 
or select another port. (Nije 
bilo mogu e otvoriti odabranu 
serijsku priklju nicu. Možda 
je u tijeku neka druga operacija 
na toj priklju nici. Pri ekajte 
dok priklju nica ne postane 
dostupna ili odaberite neku 
drugu priklju nicu.)

Provjerite ne koristi li neki drugi program odabranu 
komunikacijsku priklju nicu ili odaberite neku 
drugu priklju nicu. Pokušajte ponovno pokrenuti 
ra unalo koje koristite i potom ponovno pro itati 
ure aj. Možda je neispravan hardver (kabel itd.) 
povezan s priklju nicom ili sama priklju nica. 
Povežite hardver s nekom drugom priklju nicom 
i ponovno pokušajte pro itati ure aj da biste lakše 
odredili problem. 
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Auto Detect could not find the 
device on any available port. 
Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port. 
(Zna ajka automatskog 
otkrivanja nije mogla prona i
ure aj ni na jednoj dostupnoj 
priklju nici. Provjerite 
kabelsku vezu, bateriju 
ure aja i status pa pokušajte 
ponovno ili pokušajte odrediti 
serijsku priklju nicu.)

Provjerite vezu izme u kabela i ra unala 
te provjerite je li status baterije ure aja 
zadovoljavaju i. Ako jest, umjesto odabira 
zna ajke automatskog otkrivanja pokušajte 
odrediti serijsku priklju nicu ra unala s kojom 
je kabel povezan.

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try 
again, try selecting a different 
port, or try to Auto Detect the 
device. (Ure aj nije prona en 
na odabranoj serijskoj 
priklju nici. Provjerite kabelsku 
vezu, bateriju ure aja i status 
pa pokušajte ponovno ili 
pokušajte odabrati neku 
drugu priklju nicu ili 
automatski otkriti ure aj.)

Provjerite vezu izme u kabela i ra unala 
te provjerite je li status baterije ure aja 
zadovoljavaju i. Ako jest, pokušajte odabrati 
neki drugi broj serijske priklju nice ra unala ili 
odaberite mogu nost automatskog otkrivanja.

Unable to communicate with 
the device. Please ensure 
you’ve attached and selected 
the correct device, check the 
cable connection, device 
battery and status, and 
try again. (Komunikacija 
s ure ajem nije mogu a.
Provjerite jeste li priklju ili 
i odabrali odgovaraju i
ure aj, provjerite kabelsku 
vezu, bateriju ure aja i status 
pa pokušajte ponovno.)

Provjerite sve odabrane postavke za itanje 
ure aja, uklju uju i naziv ure aja, serijski broj 
i vrstu veze. Provjerite uz to jesu li ure aj, kabel 
i ra unalo ispravno povezani. Provjerite jesu li 
baterija i status alarma ure aja zadovoljavaju i.
Ponovno pokušajte izvršiti itanje.

Unexpected response… 
retrying (n%) (Neo ekivani 
odgovor… pokušavam 
ponovno (n%))

S ure aja je pro itana neo ekivana vrijednost. 
Sustav pokušava ponovno uspostaviti 
komunikaciju sve dok ne odustanete ili 
dok komunikacija ne uspije.

Pogreška pri itanju ure aja Objašnjenje
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Pogreške pri stvaranju izvješ a

Više podatkovnih unosa za isti datum

Ako postoji više podatkovnih unosa za isti datum i vrijeme za isti 
ure aj, sustav e to protuma iti kao sukob koji nije mogu e razriješiti. 
Izvješ a stvorena pomo u tih podataka s ure aja ne e sadržavati 
podatke koji se preklapaju. 

The communication device 
was found, but the pump 
(<serial #>) is not 
responding. Please verify the 
pump’s serial number, place 
the pump closer to the 
communication device to 
minimize interference, check 
pump battery and status. 
(Komunikacijski je ure aj 
prona en, no pumpa 
(<serijski br.>) ne odgovara. 
Provjerite serijski broj pumpe, 
postavite je bliže 
komunikacijskom ure aju da 
biste minimizirali smetnje te 
provjerite bateriju pumpe 
i status.)

Provjerite jeste li unijeli ispravan serijski broj 
pumpe. Ako niste, ponovno unesite ispravan 
serijski broj. Ako je serijski broj ispravan, pokušajte 
pomaknuti pumpu bliže komunikacijskom ure aju ili 
udaljiti komunikacijski ure aj i pumpu od mogu ih 
smetnji (primjerice drugih radiofrekvencijskih 
ure aja) ili pak provjeriti bateriju pumpe i status 
isporuke.

This pump is delivering 
a temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again. (Pumpa isporu uje 
privremenu bazalnu dozu. 
Otkažite bazalnu dozu ili 
pri ekajte dok ne završi, 
a zatim pokušajte ponovno.)

Pumpa koju pokušavate pro itati isporu uje 
privremenu bazalnu dozu. Pri ekajte dok 
privremena bazalna isporuka ne završi da biste 
pro itali pumpu ili otkažite privremenu bazalnu 
dozu i potom pro itajte pumpu.

This pump has active errors 
or alarms. Please clear the 
alarms and try again. (Na 
pumpi su aktivne pogreške 
ili alarmi. Poništite alarme 
i pokušajte ponovno.)

Na pumpi su aktivni alarmi koji sprje avaju itanje. 
Pro itajte upute za alarm da biste doznali kako 
ga poništiti. Poništite alarm i pokušajte ponovno 
pro itati pumpu.

This pump is delivering 
a bolus. Please cancel 
the bolus or wait until it 
completes, and then try 
again. (Pumpa isporu uje 
bolus. Otkažite bolus ili 
pri ekajte dok ne završi, 
a zatim pokušajte ponovno.)

Pumpa koju pokušavate pro itati isporu uje bolus. 
Pri ekajte dok bolus ne završi da biste pro itali 
pumpu ili odustanite od bolusa i potom pro itajte 
pumpu.

The device returned invalid 
entries; all data read will be 
discarded. (Ure aj je poslao 
nevaljane unose; svi pro itani 
podaci bit e odba eni.)

Obratite se lokalnom predstavniku u svojoj državi 
(pogledajte Pomo , na stranici 3).

Pogreška pri itanju ure aja Objašnjenje



Korisni ki priru nik za CareLink™ Pro    Otklanjanje poteško a      65

Možete pokušati prilagoditi razdoblje izvješ a da biste zaobišli podatke 
koji se preklapaju ili ukloniti ure aj iz sustava i potom ga vratiti da biste 
poništili prethodna o itanja.

Sustav e ignorirati podatke

Ako je vrijeme na ure aju promijenjeno te rezultira preklapanjem 
podataka ili prazninama izme u podataka u trajanju od tri sata ili dulje, 
sustav ne uvrštava taj dio podataka pri stvaranju izvješ a.

Pogreške prilikom sigurnosnog kopiranja i vra anja

Bazu podataka nije mogu e zaklju ati

To zna i da sustav koristite u okruženju s više korisnika, a drugi su 
korisnici prijavljeni. Sustav ne e dopustiti stvaranje sigurnosne kopije 
baze podataka dok drugi korisnici izvršavaju zadatke koji mogu utjecati 
na bazu podataka. Nakon što svi korisnici iza u iz softvera CareLink Pro, 
možete stvoriti sigurnosnu kopiju baze podataka.

Sigurnosno kopiranje ili vra anje baze podataka ne izvršava se do kraja

Drugi se korisnici ne mogu prijaviti, a sigurnosno kopiranje ili vra anje 
nije mogu e dovršiti. Nazovite liniju za pomo  ili se obratite lokalnom 
predstavniku u svojoj državi (pogledajte Pomo , na stranici 3).

Vra anje baze podataka ne uspijeva

Datoteka sigurnosne kopije baze podataka koju pokušavate koristiti 
za vra anje je ošte ena. Pokušajte izvršiti vra anje s nekom drugom 
datotekom sigurnosne kopije.

Deinstalacija softvera

Ako želite deinstalirati CareLink Pro, poduzmite sljede e korake:

1 Otvorite Control panel (Upravlja ku plo u) putem izbornika Start
u sustavu Windows.

2 Odaberite Add or Remove Programs (Dodaj ili ukloni programe). 
Prikazuje se prozor »Add or Remove Programs« (Dodaj ili ukloni 
programe) u sustavu Windows.

3 Pomaknite se dolje do programa Medtronic Carelink Pro i kliknite ga.

4 Kliknite REMOVE (Ukloni). Prikazat e se arobnjak InstallShield.
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5 Kliknite NEXT (Dalje). Prikazuje se poruka u kojoj morate potvrditi da 
želite ukloniti program.

6 Kliknite YES (Da). Pokre e se program za deinstalaciju koji s ra unala 
uklanja program i sve njegove datoteke. Po završetku deinstalacije na 
zaslonu arobnjaka prikazuje se poruka koja potvr uje deinstalaciju.

7 Kliknite FINISH (Završi).
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Tablica s ikonama
Ikone i simboli na ambalažnim naljepnicama i opremi opisani su 
u sljede oj tablici:

Opis Ikona

Jedan komad po kutiji/pakiranju (1x)

Pažnja: pogledajte upute za upotrebu

Priložen CD

Priloženi važni dokumenti

Kataloški broj REF

Oznaku CE za medicinski ure aj izdalo 
mjerodavno tijelo
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D
od

at
ak

 A

CSV podaci A

U ovom su dodatku opisani podaci iz softvera CareLink™ Pro koje vidite 
kada izvezete podatke u oblik CSV. 

Definicije podataka u stupcima

Naslov stupca Definicija

Index (Kazalo) Redoslijed kojim su podaci snimljeni na ure aj.

Date (Datum) Datum na koji su podaci snimljeni na ure aj.

Time (Vrijeme) Vrijeme u koje su podaci snimljeni na ure aj.

New Device Time 
(Novo vrijeme ure aja)

Novi datum i vrijeme ako su oni promijenjeni na 
ure aju.

BG Reading 
(mg/dL or mmol/L) 
(O itanje glukoze u krvi 
(mg/dL ili mmol/L))

O itanje razine glukoze u krvi zabilježeno mjera em,
monitorom Guardian ili pumpom. Ako podaci 
potje u iz pumpe ili monitora Guardian, u tom je 
stupcu prikazana ru no izmjerena razina glukoze 
u krvi i razina primljena s povezanog mjera a.

Linked BG Meter ID 
(ID povezanog mjera a
glukoze u krvi)

Serijski broj mjera a koji šalje o itanja razine 
glukoze u krvi na ure aj.

Basal Rate (U/h) 
(Bazalna stopa (J/h))

Brzina isporuke aktivnog bazalnog inzulina 
u jedinicama po satu.

Temp Basal Amount 
(Koli ina privremenog 
bazalnog inzulina) 

Ako je privremeni bazalni inzulin primijenjen 
na pumpi, ova vrijednost ozna ava koli inu 
privremenog bazalnog inzulina. 

Temp Basal Type 
(Vrsta privremenog 
bazalnog inzulina)

Namještanje vrste privremenog bazalnog inzulina 
(stopa inzulina ili postotak bazalnog).

Temp Basal Duration (m) 
(Trajanje privremenog 
bazalnog inzulina (min.))

Vrijeme u minutama za isporuku privremenog 
bazalnog inzulina (vidi vrstu gore).

Bolus Type (Vrsta bolusa)
Vrsta isporuke bolusnog inzulina [normalni, 
etvrtasti, dvojni (normalni dio) ili dvojni 

( etvrtasti dio)].
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Bolus Volume Selected (U) 
(Odabrana koli ina 
bolusa (J))

Broj jedinica inzulina odabranih za isporuku 
tijekom isporuke inzulina u bolusu.

Bolus Volume Selected (U) 
(Isporu ena koli ina 
bolusa (J))

Broj jedinica inzulina koje su zapravo isporu ene 
tijekom isporuke inzulina u bolusu.

Programmed Bolus Duration (h)
(Programirano trajanje 
bolusa (h))

Trajanje etvrtastog bolusa ili etvrtastog dijela 
bolusa s dvojnim valom.

Prime Type 
(Vrsta po etnog ciklusa)

Ru ni ili fiksni. Ru ni po etni ciklus koristi se samo 
nakon premotavanja, za ispunjavanje kompleta 
infuzijskih cijevi inzulinom prije uvo enja. Fiksno 
pokretanje koristi se nakon umetanja cijevi za 
infuziju za ispunjavanje meke kanile inzulinom 
nakon uklanjanja igle uvodnika.

Prime Volume Delivered (U) 
(Isporu ena koli ina 
po etnog ciklusa (J))

Broj jedinica inzulina koje su zapravo isporu ene 
za po etni ciklus.

Alarm Naziv alarma koji se aktivirao.

Suspend (Prekid) Utvr uje prekinuto stanje pumpe.

Rewind (Prematanje) Datum i sat kada je ure aj premotan.

BWZ Estimate (U) 
(BWZ procjena (J))

Procjena koli ine inzulina u bolusu ako je 
izra unata zna ajkom arobnjaka za bolus 
(Bolus Wizard) na pumpi Paradigm.

BWZ Target High BG 
(mg/dL or mmol/L) 
(Gornja ciljna razina 
glukoze u krvi za BWZ 
(mg/dL ili mmol/L))

Postavke za gornji dio raspona ciljne razine 
glukoze u krvi koje koristi zna ajka arobnjaka 
za bolus (Bolus Wizard).

BWZ Target Low BG 
(mg/dL or mmol/L) 
(Donja ciljna razina 
glukoze u krvi za BWZ 
(mg/dL ili mmol/L))

Postavke za donji dio raspona ciljne razine 
glukoze u krvi koje koristi zna ajka arobnjaka 
za bolus (Bolus Wizard).

BWZ Carb Ratio 
(Omjer ugljikohidrata za BWZ)

Postavka za omjer inzulina i ugljikohidrata. Ako 
se kao jedinice koriste grami, omjer je broj grama 
pokriven jednom jedinicom inzulina. Ako se kao 
jedinice koriste razmjene, omjer je broj jedinica 
inzulina potreban za pokrivanje jedne razmjene.

BWZ Insulin Sensitivity 
(Osjetljivost inzulina za BWZ)

Postavka za osjetljivost inzulina. Osjetljivost 
inzulina koli ina je za koju jedna jedinica inzulina 
smanjuje razinu glukoze u krvi. Te podatke koristi 
zna ajka arobnjaka za bolus (Bolus Wizard).

BWZ Carb Input (Unos 
ugljikohidrata za BWZ)

Koli ina ugljikohidrata unesena u arobnjak za 
bolus (Bolus Wizard) koja se koristi za procjenu 
bolusa.

BWZ BG Input 
(mg/dL or mmol/L) 
(Unos razine glukoze u krvi 
za BWZ (mg/dL ili mmol/L))

O itanje glukoze u krvi uneseno u arobnjak za 
bolus (Bolus Wizard) koje se koristi za procjenu 
bolusa.

BWZ Correction Estimate (U) 
(Ispravak procjene BWZ-a (J))

Jedinice inzulina u bolusu radi korekcije razine 
glukoze u krvi, izra unate putem zna ajke 
arobnjaka za bolus (Bolus Wizard).

Naslov stupca Definicija
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Više pojedinosti o CSV datotekama koje izvozi 
CareLink Pro

Naslov na vrhu CSV datoteke obuhva a sljede e:

• ime bolesnika
• popis odabranih ure aja i njihovih serijskih brojeva
• odabrani raspon datuma

Svaki blok stupaca ima naslov koji obuhva a sljede e:

• naziv ure aja na koji se blok podataka primjenjuje
• serijski broj tog ure aja 

Ako se podaci ne prikazuju prema o ekivanjima

Postoje brojni razli iti faktori koji mogu uzrokovati da prikaz CSV 
podataka bude druk iji od o ekivanog.

• Promjene datuma ili vremena na ure aju mogu promijeniti redoslijed 
zapisa ili uzrokovati prikaz zapisa izvan odabranog raspona datuma.

• Ako izme u itanja ure aja postoji veliki razmak, podaci za taj ure aj
mogu biti prikazani u više blokova.

BWZ Food Estimate (U) 
(Procjena hrane za BWZ (J))

Jedinice inzulina u bolusu koje je potrebno dati 
radi pokrivanja o ekivane koli ine potrošenih 
ugljikohidrata, izra unate pomo u arobnjaka 
za bolus (Bolus Wizard).

BWZ Active Insulin (U) 
(Aktivni inzulin za BWZ (J))

Koli ina aktivnog inzulina izra unata kao preostala 
u tijelu iz prijašnjih isporuka inzulina u bolusu pri 
odre ivanju procijenjene koli ine bolusa putem 
zna ajke arobnjaka za bolus (Bolus Wizard).

Sensor Calibration BG 
(mg/dL or mmol/L)
(Razine glukoze u krvi 
za kalibraciju senzora
(mg/dL ili mmol/L))

Vrijednost razine glukoze u krvi koja se koristi 
za kalibraciju senzora u mg/dL ili mmol/L.

Sensor Glucose 
(mg/dL or mmol/L) 
(Glukoza na senzoru 
(mg/dL ili mmol/L))

Vrijednost glukoze senzora.

ISIG value (Vrijednost ISIG) Ulazni signali (ISIG) koje o itava senzor, izraženi 
u nanoamperima (nA).

Naslov stupca Definicija
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R
je

ni
k

Rje nik

A
A1c  Glikozilirani hemoglobin
Average Area Under the Curve (AUC) (Prosje no podru je ispod 
krivulje)  Prosje na koli ina izloženosti hiperglikemiji ili hipoglikemiji 
u trajanju isporuke iz senzora.

B
Bazalna stopa inzulina  Postavka pumpe koja pruža trajnu infuziju 
inzulina radi održavanja stabilne razine glukoze u krvi izme u obroka 
i tijekom no i. Bazalni inzulin oponaša isporuku inzulina iz guštera e, 
koji ispunjava sve potrebe tijela za inzulinom nevezano za hranu.
Bazalni inzulin  Infuzija inzulina koju automatski svakog sata 
isporu uje inzulinska pumpa na temelju unaprijed programiranih 
profila i personaliziranih stopa postavljenih u pumpi. Pumpa isporu uje 
dnevnu infuziju inzulina koja obi no pokriva »pozadinske« potrebe za 
inzulinom tijekom razdoblja posta (primjerice tijekom no i i izme u
obroka).

Bolus etvrtastog vala (Square Wave® bolus)  Bolus koji se 
isporu uje ravnomjerno tijekom odre enog vremenskog razdoblja 
(30 minuta do osam sati). 

Bolus dvostrukog vala (Dual Wave® bolus)  Kombinacija normalnog 
bolusa, koji se odmah isporu uje, i etvrtastog (Square Wave) bolusa. 

etvrtasti se dio ravnomjerno isporu uje tijekom odre enog 
vremenskog razdoblja.
Bolus hrane  Doza inzulina koja se daje za pokrivanje o ekivanog 
porasta glukoze u krvi do kojeg dolazi nakon jela.
Bolus ispravljanja  Koli ina inzulina potrebna za povrat visoke razine 
glukoze u krvi natrag u ciljni raspon.

C
CareLink™ Personal Internetska usluga koja omogu uje upravljanje 
podacima o dijabetesu putem interneta.
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CareLink™ USB Ure aj koji se koristi za prenošenje podataka 
pohranjenih u inzulinskoj pumpi Medtronic Diabetes Paradigm ili 
monitoru Guardian REAL-Time u softver CareLink™ putem USB 
priklju ka na ra unalu.
CH  Ugljikohidrati
Com-Station  Ure aj koji se koristi za preuzimanje podataka iz pumpe 
MiniMed 508 i prolaznih podataka iz mjera a drugih proizvo a a na 
ra unalo.
ComLink  Ure aj za primopredaju radijskih frekvencija (RF) koji 
se koristi za preuzimanje podataka iz pumpe Paradigm ili sustava 
Guardian REAL-Time CGM na ra unalo.

D
Dio etvrtastog vala (Square Wave)  (Sq) Drugi dio bolusa dvojnog 
vala (Dual Wave). etvrtasti se dio ravnomjerno isporu uje tijekom 
odre enog vremenskog razdoblja nakon isporuke trenutnog dijela.
Donja razina glukoze  Pumpa e aktivirati alarm ako senzor upu uje 
na to da je glukoza korisnika na senzoru jednaka toj vrijednosti ili ve a
od nje. Tu zna ajku možete uklju iti i isklju iti.

E
Easy Bolus™  Metoda isporuke normalnog bolusa korištenjem gumba 
Easy Bolus na pumpi.
Ekspresni bolus  Metoda isporuke bilo koje vrste bolusa putem 
gumba express bolus (ekspresni bolus) na pumpi.

F
Faktor bolusa ispravljanja (faktor osjetljivosti)  Koliko e
1,0 jedinica inzulina spustiti vašu razinu glukoze u krvi. Taj se faktor 
koristi za izra un koli ine bolusa ispravljanja u krvi kada je razina 
še era u krvi visoka.
(razina glukoze u krvi) – (ciljana razina glukoze u krvi) = X.  
X ÷ (faktor bolusa ispravljanja) =  
koli ina bolusa ispravljanja

G
GK Glukoza u krvi
Gornja razina glukoze  Pumpa e aktivirati alarm ako senzor upu uje 
na to da je glukoza korisnika na senzoru jednaka toj vrijednosti ili ve a
od nje. Tu zna ajku možete uklju iti i isklju iti.
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H
HbA1c  Glikozilirani hemoglobin
HbA1c Test  Test za hemoglobin A1c koristi se za tuma enje 
razine glukoze u krvi ili prosjeka razine tijekom razdoblja od dva 
do tri mjeseca.
Hiperglikemija  Povišena razina glukoze u krvi ustanovljena 
nadzorom razina glukoze u krvi. Može obuhva ati navedene 
simptome ili neke od njih: mu nina, povra anje, zamagljen vid, 
glavobolja, želu ane poteško e, esto mokrenje uz velike koli ine
mokra e i letargija. 
Hipoglikemija  Niska razina glukoze u krvi ustanovljena nadzorom 
razina glukoze u krvi. Može obuhva ati navedene simptome ili neke 
od njih: prekomjerna glad, drhtanje ili tremori, znojenje, »plešu e« slike 
pred o ima, vrtoglavica, glavobolja, nejasan govor, nagle promjene 
raspoloženja ili promjena osobnosti.

I
ID odašilj.  Serijski broj odašilja a koji se trenutno koristi.
Inzulin u bolusu  Doza inzulina koja se daje radi pokrivanja neo ekivanog 
porasta glukoze u krvi (primjerice nakon obroka ili me uobroka) ili za 
snižavanje visoke razine glukoze na ciljani raspon.

J
Jedinice ugljikohidrata  Unos hrane pri korištenju arobnjaka 
Bolus Wizard. Unosi se kao grami ili razmjene (ugljikohidrata).

K
Komplet za infuziju  Ure aj koji se koristi za umetanje i u vrš ivanje 
kanile ispod kože i prijenos inzulina na mjesto umetanja putem cjev ica 
iz pumpe.
Koncentracija inzulina  Snaga ili vrsta inzulina koji je lije nik prepisao 
korisniku. To utje e na stopu inzulina koju pumpa isporu uje. Ako se 
koncentracija inzulina u korisnika promijeni, potrebno je reprogramirati 
uzorke bazalnog inzulina te maksimalne stope bazalnog i bolusa 
u pumpi.
Korak  Dodatak inzulina koji postavljate i koristite za isporuku putem 
zna ajke Easy Bolus.

M
Maksimalni bazalni inzulin  Maksimalna koli ina bazalnog inzulina 
koju e pumpa isporu iti u danom trenutku. (Postavlja korisnik.)
Maksimalni bolus  Maksimalna koli ina inzulina u bolusu koji 
e pumpa isporu iti u danom trenutku. (Postavlja korisnik.)
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Mjera Medicinski ure aj za odre ivanje približne koncentracije 
glukoze u krvi. Mala kap krvi postavlja se na jednokratnu testnu vrpcu 
koju mjera  o itava i koristi za izra un razine glukoze u krvi. Mjera
zatim prikazuje razinu u mg/dL ili mmol/L. 
μL mikrolitre
Mogu nost mjera a Zna ajka koja pumpi omogu uje primanje 
o itanja glukoze u krvi s povezanog mjera a razine glukoze u krvi.  

N
Normalni bolus  Trenutna isporuka odre ene jedini ne koli ine
inzulina. 

O
Omjer razmjene  Koli ina inzulina potrebna za pokrivanje jedne (1) 
razmjene ugljikohidrata. (Pogledajte tako er: omjer ugljikohidrata.)
Omjer ugljikohidrata  Koli ina ugljikohidrata koju pokriva jedna 
jedinica inzulina. (Pogledajte tako er: omjer razmjene.)
Osjetljivost inzulina  Koli ina mg/dL (ili mmol/L) za koju jedna 
jedinica inzulina smanjuje razinu glukoze u krvi (GK). (Podaci iz 
arobnjaka Bolus Wizard.)  

P
Podsjetnik za kalibraciju  Vrijednost podsjetnika za kalibraciju jest 
vremensko razdoblje prije isteka trenutne kalibracijske vrijednosti 
prema kojoj korisnik želi podsjetnik za kalibraciju tako da pumpa izdaje 
alarm mjera a razine glukoze u krvi. Ako je, primjerice, podsjetnik za 
kalibraciju postavljen na dva sata, alarm mjera a razine glukoze u krvi 
aktivirat e se dva sata prije no što je potrebno izvršiti kalibraciju.
Prekid  Funkcija pumpe koja zaustavlja svu isporuku inzulina. Isporuke 
trenutnog bolusa i/ili po etnog ciklusa se otkazuju. Isporuka bazalnog 
inzulina zaustavlja se do ponovnog pokretanja. 
Prijenos  Postupak prijenosa podataka iz pumpe ili mjera a
na poslužitelj CareLink™ Personal.
Priv.  Privremeno
Privremeni bazalni (priv. bazalni)  Privremeni jednokratni bazalni 
inzulin odre ene koli ine i trajanja. Koristi se za ispunjavanje potreba 
za inzulinom za posebne aktivnosti ili uvjete koji nisu dio normalne 
dnevne rutine.
Profil bazalnog inzulina  Stopa bazalnog inzulina s vremenom 
po etka i završetka. Korisnik može programirati nekoliko razli itih 
profila u svoju pumpu uz razli itu stopu bazalnog inzulina za svaki 
profil tijekom 24 sata radi postizanja boljeg nadzora nad razinom 
glukoze.
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R
RF  Radijska frekvencija (RF). 
Ru ni bolus  Dodatna stavka dostupna na izborniku BOLUS MENU 
kada je zna ajka arobnjaka Bolus Wizard aktivna. Metoda programiranja 
bolusa bez arobnjaka Bolus Wizard. 

S
Standardni uzorak  Vaš normalni bazalni inzulin koji podržava 
svakodnevne aktivnosti. Kada je zna ajka Patterns (Uzorci) 
isklju ena, pumpa koristi standardni (bazalni) uzorak.

T
Test na ketone  Ketoni su otpad koji se stvara kada je tijelo prisiljeno 
sagorijevati tjelesnu mast umjesto glukoze radi dobivanja energije. To 
može biti znak nedostatka inzulina u tijelu. Test na ketone mjeri koli inu
ketona koncentriranu u krvi ili urinu.
Test A1c  Test za hemoglobin A1c koristi se za tuma enje razine 
glukoze u krvi tijekom odre enog vremenskog razdoblja.

U
Upozorenje da je rezervoar na niskoj razini  Programibilno 
upozorenje koje se pojavljuje kada odre eni broj jedinica ostane 
u rezervoaru pumpe ili kada preostane odre eno vrijeme prije 
pražnjenja rezervoara.
Uzorak A/B  Bazalni uzorak koji podržava razine aktivnosti koje nisu 
dio vaših svakodnevnih navika, ali su uobi ajene u vašem stilu života. 
Takve aktivnosti mogu obuhva ati sport kojim se bavite jedanput tjedno, 
promjenu navika spavanja tijekom vikenda, duža razdoblja ja e ili 
slabije aktivnosti ili menstruacijski ciklus.
Uzorci bazalnog inzulina  Korisnik može programirati do tri razli ita
uzorka stope bazalne doze u svoju pumpu za isporuku bazalnog 
inzulina: standardni uzorak, uzorak A i uzorak B. Za svaki uzorak 
mogu e je postaviti do 48 stopa bazalnog inzulina.
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V
Veza  Za uklju ivanje i postavljanje mogu nosti mjera a koji pumpi 
omogu uje primanje o itanja glukoze u krvi iz mjera a CONTOUR®

LINK, OneTouch® UltraLink™ ili Paradigm Link®.
Koristi se i u sustavu za referencu na hipertekstne veze. Kada kliknete 
hipertekstne veze, one vas vode do nekog drugog mjesta u sustavu ili 
na neko drugo web-mjesto.

Z
Zvuk bolusa  Pumpu je mogu e programirati tako da korisnik uje 
zvuk kada odabere koli inu inzulina u bolusu (npr. 0,5 ili 1,0 jedinica) 
za isporuku. To je korisno u situacijama kada je teško vidjeti gumbe 
na pumpi.
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sustav nije dostupan 60

Brisanje bolesnikova ure aja iz 
sustava 42
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Guide Me (Vodi me) 13
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sustav mrežne pomo i 14
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radni prostori 10
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L
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telefonski brojevi 3
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unos za CareLink Pro 8
M
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aktiviranje 42
brisanje 42
deaktiviranje 41
dodavanje u sustav 39
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Monitor Guardian
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Monitori Guardian
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Personal 26

postoje i ra un 26
pozivnica e-poštom 28

primanje podataka 30
N
Naru ivanje

mjera i 5
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pumpe 5
ure aji 5
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Naziv mjera a
ekvivalentni ure aji 5
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izvješ e s dnevnim 
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izvješ e zapisnika 55
snimka postavki ure aja 55

Obavijest o ažuriranjima softvera 58
Odabir
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uvrštavanja 52
Op e preference

postavljanje 19
Osnovni zadaci u programu 

CareLink Pro 16
Osobno ra unalo

povezivanje ure aja s njim 32
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ComLink 34
Com-Station 34

kabeli
serijski 33
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mogu nosti mjera a 34
pregled 32
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serijske 33
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Otvaranje
radni prostor Reports (Izvješ a) 46
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postavljanje
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komunikaciju mjera a 4, 5
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dodavanje 
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Preuzimanje ažuriranja softvera 58
Prijava

u CareLink Pro 8
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postoje i ra un 26
pozivnica e-poštom 28

Primanje podataka iz ure aja 
bolesnika 43

Primarni zadaci u programu 
CareLink Pro 16
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naru ivanje 5
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Radni prostori 10
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izvješ ivanja 46
odabir ure aja 48
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S
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Sigurnost korisnika

indikacije za upotrebu 6
kontraindikacije 6
upozorenja 6

Snimka postavki ure aja
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Stvaranje izvješ a 46
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T
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komunikaciju 
mjera a 4, 5

mjera i glukoze u krvi 3
pohrana u sustavu 41
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ComLink 34
Com-Station 34
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serijski 33
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mogu nosti mjera a 34
pregled 32
ra unalne veze

serijske 33
USB 33

primanje podataka 43
novi podaci za izvješ a 49

provjera ima li podataka za 
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